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ADVANCED CS TUTORIALS

Using Coordinate Systems

* Introduction

» Coordinate System Basics
+ 3-Axis Part: Angled Webs
* 4-Axis Part: Slot Block

* 5-Axis Part: Hinge

Introduction

The following tutorials will demonstrate how to work with coordinate systems or “planes.” There are
three primary coordinate systems you should become familiar with when defining parts, the XY, XZ
and YZ coordinate systems.

You should already be familiar with the XY plane. The X axis is horizontal, the Y axis is vertical and
the Z axis is the depth axis. The depth axis of a plane is not visible but its orientation can be seen by

a“+” or “" at the origin of the plane. The plus or minus symbol represents whether we are looking at
the positive or negative side of the depth axis.

All standard milling parts are defined from the XY plane (which cannot be modified). The XZ and YZ
axes are defined by rotating 90° clockwise about the X or Y axis. From these coordinate systems
we can define other coordinate systems that are rotated, flipped or modified at an angle.

The first tutorial begins with a general overview of different concepts when working with Coordinate
systems. Then, we will explore adding geometry to modified Coordinate Systems.

Terms

CS
The term CS means “coordinate system” and is used frequently.

CS1, CS2, etc.:
CS followed by a number denotes a particular CS in the CS list. All coordinate systems have a
number and can be named.

mm

All parts in these tutorials are in metric values. A millimeter is about 1/25th of an inch. The part files
generally have fairly round numbers so the mental conversion to inch should be fairly easy, i.e.
100mm is about 4".
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Coordinate System Basics

This exercise is designed to introduce you to creating coordinate systems
and to familiarize you with the interface items used. The exercise has two
parts. The first part is simply creating the standard coordinate systems (the
XY, XZ and YZ planes) at the origin of the part. In the second part of the
exercise we will learn another method for making coordinate systems as
well as get an introduction on modifying the planes.

Creating the Primary Planes

The XY Plane

We will start by creating a 100mm cube. You do not need to select a specific MDD as we will not
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be creating any toolpath for this part but you should select a vertical mill MDD to ensure your

results look the same as those in the tutorial. We have selected a 5 Axis Vertical Mill MDD for this

example as that is what would be required to access all the coordinate systems.

1. Launch GibbsCAM if it is not running.

2. Ensure that the Show Stock & Origin and Show CS items are active.
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3. Create a new part named CS Basics with dimensions as shown below.

CS Basicsvnc Workspace | interop Pesttions | Intemmediate Tooling

3= )|

General | Comments | Machining Preferences | Machine Setup

Stock Size and Part Origin
o) [Eeeni) x [50

Close

Machine (5 Asds Horizortal Hil

Material

Family [STAINLESS STEEL, ']

Alloy Group [ASTM A296 -]

Hardness  [275ta 325 -

Alloys Default Aoy

‘ Inches
@ Millimeter

Mill C
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nce |15

CAT 40 v

Tool Change [H

The system automatically creates the XY plane when a new part is made. This base coordinate

system may not be modified. The position of the XY plane is defined by the origin of the part, as
set up in the Document Control dialog. We placed the origin at the very center of the 100mm

cube.
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4. Switch to the isometric view (Ctr1+I)and unzoom (Ctrl+U) the
part.

You can now clearly see the origin and that the XY plane is at the center of the part. The + at the
center of the axes markers indicates that we are looking at the positive end of the depth axis. A
“~” would indicate the negative view.

Creating the XZ and YZ Planes

1. Openthe CS list and Coordinate System palette by c1icking onthe Coordinate
Systems and CS palette buttons in the Main palette, or by double-clicking the CS

button on the status bar at the bottom of the screen. S
k —
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——

The CS list is used to create, show and switch between coordinate systems. The CS palette is
used to modify the current coordinate system. The name of the current coordinate system is
displayed in the CS palette’s title bar.

When you open these items you will only see the XY plane in the CS list. All of the buttons in the
CS palette are disabled or grayed out. This is because the XY plane cannot be modified.

cs & [T

Comm... WFD
l.

' 1 3

CS List CS Palette

2. Goto File>Preferences>Coordinate Systems. Ensure the settings
as shown right are selected.

3. Click New CSinthe CS list to create a new coordinate system.
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= P— The new coordinate system is called User CS. The new coordinate
systemis in same place as the XY plane. By default, newly
created coordinate systems are based on the last active
coordinate system.

Now that we have a coordinate system that can be
A Loz XY XZ YZ 3¢t modified, the CS palette is active and can be used to
modify the coordinate system.

4. Clickthe XZ button in the CS palette. XZ

The coordinate system has been repositioned. At the origin of the
CS you can see that the horizontal axis is marked as X and the
vertical axis is marked as Z. We will now make the YZ plane.

5. (Click New CSto make a second coordinate system.

cs BHE=
En:nmn:ent
The new coordinate system is called User CS and it is based on the 1 S 5 plane
XZ plane. Each new CS will continue to increment the name in the 2 MY User C5

list.

Mo 05

- There are three short red lines at the center of the part. These lines are a marker for the
origin of a visible coordinate system. A visible CS has an open eye in the CS list. When
a CSis visible and not active the grid is not displayed.

We will now modify the current CS to be the YZ plane.

6. ClicktheYZ buttoninthe CS palette. YZ
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The coordinate system has been repositioned. At the origin of the CS
you can see that the horizontal axis is marked as Y and the vertical
axis is marked as Z. The Z is backwards indicating that we are looking
at the negative side of the depth axis.

We have just created the three primary planes of a mill part. The origin of each CS is at the
center of the part. We will now modify this part to make it a little more useful by defining the
coordinate systems at the edge of our stock boundary. While doing this we will learn how to
name coordinate systems and get an introduction to moving them around.

Modifying the Properties of Coordinate Systems

Naming Coordinate Systems

It is highly recommended that you give coordinate systems a name or description. This is
especially true when working with parts that contain more than a few coordinate systems.

1. With CS3 highlighted Double-click the name field.
The name field becomes a text entry field.

2. Rename CS3YZ plane.

3. Rename CS2XZ plane.

4. Select CS3YZ plane.

Displaying and Hiding Coordinate Systems

There is an eye icon *& next to each coordinate system in the CS list. The eye works just like
the workgroup list. When the eye is open you can see a CS, when closed the CS is hidden. The
CS listis different from the Workgroup list in that hiding a workgroup will hide the geometry that
is in the workgroup. Hiding a coordinate system does not hide any geometry associated with the

CS. Hiding a CS merely hides the red coordinate system marker - that designates the origin
ofaCS.

1. Double-clickthe eyeicon nextto CS2 (the XZ plane) to hide the coordinate system. o
Did you notice how the red coordinate system marker disappeared?

2. Double-click the closed eye icon nextto CS2 to show the CS.

The coordinate system marker is now back.
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Switching Coordinate Systems

Switching between coordinate systems is very easy and there are multiple ways to change the
current CS. The most common method is to use the CS list. Simply c1ick anywhere inthe CS
comment, or number in the dialog box and you will switch to it.

1. Click CS2XZ plane.

Did you notice how the CS palette changed from the YZ plane to the XZ plane? We will now use
another method to switch between coordinate systems — the Coordinate Systems button in the
Main palette.

ke —

2. Closethe CSlistby clicking the close button or the CS list button. E__

When the CS list is not open the CS list button displays a small black triangle in the bottom left
corner of the icon. The triangle signifies that this button has a flyout menu similar to the standard
menus such as Edit > Select. Hold the button down to open flyout CS list. This is a quick list to all
the coordinate systems defined in the part.

3. Clickand hold the CS list button until a menu apears. Continue holding the mouse
until you have highlighted CS3, the YZ plane. Let go the mouse and the coordinate e ——
system becomes active.

There is a third method for switching to a different CS. Clicking on the coordinate
@ system marker of a visible CS will switch you to that CS. Since the origins for the

current coordinate systems are virtually identical, it would be difficult to

demonstrate this. However, it is discussed in a later step in this tutorial.

Deleting Coordinate Systems

Deleting a coordinate system is as easy as making one. You simply select it and press the delete
key on your keyboard. Alternatively, you may click the trash icon at the bottom corner of the
workspace. If there is geometry assigned to the CS it may be deleted or changed to CS11.

bt —

1. Openthe CS list. K==
2. Remove CS3YZ plane, by pressing the Trash button . ﬁl
3. Remove CS2 XZ plane, by pressing the Delete key.
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You should have only CS1 in the list. We are now ready to move on to learning how to modify
coordinate systems.

Changing the Origin of a Plane

We will now redefine the stock boundaries so the part’s primary coordinate systems are on the
edge of the stock. We will define the part so that all geometry will be in the H+V+ quadrants.
Therefore we want the coordinate system origins on the bottom left corner of the part’s sides.
This setup is useful for 5-axis machines that can access these faces.

Pt

b
o X7

5\\ )
I

The XY Plane

1. Open the Document Control dialog and set the dimensions to be +X= 100, -X= 0, +Y= 1
100,-Y=0, +Z= 100,-7= 0. =

This placed the XY plane at the bottom of the cube, but we want it at
the top. Since CS1 cannot be modified, the only way to accomplish
this is to change the Document Control dialog settings.

2. Change the Document Control dialog settings to +X= 100, -X= 0, +Y= 100, -Y=0, +Z= 1
0,-7= -100. =

As you can see, the XY plane is now at the top face of the
workspace stock with the origin at the bottom left corner of the
plane.
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Using XYZ and HVD Values

We will first create and name the XZ and YZ planes. These planes will be identical to the XY
plane but we will move the coordinate systems into place.

Click New CSinthe CS list.

new CS, and switch between different coordinate systems. For more information on
the menu, see “Switching Coordinate Systems” on page 8.

1.
‘ ® Alternatively, you can use the Coordinate Systems button flyout menu to create a
2. Renamethe CS XZ plane.

3

Create another new coordinate system and name it YZ plane.

4. Selectthe XZ plane in the CS listand c1ick the XZ button. XZ

5. Selectthe YZ plane inthe CS listand c1ick the YZ button.

While these coordinate systems are fully defined as the XZ
and YZ planes, they still need to be modified to be on the
lower left corner of the plane. The origin of the XZ plane
must be moved down to the bottom left corner and the YZ
plane must be moved across the part and then down.

6. Selectthe XZ plane CS.

]
7. Clickthe Change CS Origin button. i

o
Change C5 Origin HESE
The Change CS Origin dialog allows you to move a @ 2 ) HVD
coordinate system’s origin in ether XYZ (absolute from the w [0 7] Duplicats
XY plane) or HVD (relative) values. We need to move this ¢ IG5
plane by -100 in Z to get it to the desired location. Z [100

8. Select XYZ and enter the data shown and Do it. Dol

10
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The origin for CS2 is now at the bottom left corner of the stock.

We will now modify the YZ plane.

9. Selectthe YZ plane by clickingthe CS marker. ~J-

We need to move the plane across the part (100mm) and down (-100mm). Since these values
are relative to the current origin, we will use the HVD option.

10. Select HVD and change the data as shown and Do it.

Change CS Origin & 1= &
) ®YZ @ HvD

Y [ Duplicate

£ 1100

¥ 100

We now have a part set up that has the three primary planes in the lower left corner of the top,
front and side of the part. We will now create another CS to illustrate another important function
for creating coordinate systems.

Using Existing Geometry

We will now try another useful method for aligning a plane. Typically, a part has an existing point
or a known point that can be used as a reference for a plane’s origin.

1. Inthe YZ plane, create the point shown.

Workgroup E A=
®o-100 F | Mone -

2. Createanew CSandnameitYZ plane reversed.

11
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If there is an existing point to use for an origin the point may be used to automatically align the
plane.

3. Select the point (which has changed from yellow to pink and will now turn to green).

4. Click the Change CS Origin button . A

5. Deselect the point.

Toggling the Depth Axis

You will notice that the axis markers for YZ plane reversed are displayed in reverse.

We will use the Toggle Depth button to change the polarity of the depth
axis. The depth axis is always indicated by a “+” or “-” sign at the
intersection of the two axes markers. The “+” indicates that the positive
direction of the depth axis in the current view is pointing forward or coming
towards you. The “-” indicates that the negative direction of the depth axis

is pointing torward you.

1. Clickthe Toggle Depth button .

When you toggle the depth, the system will rotate the depth axis 180°
around the vertical axis. This has the effect of inverting or flipping the
direction of the horizontal axis as well as the depth axis. The vertical
axis is not affected. This only has an effect on the orientation of the
coordinate system not on the actual orientation of the part.

Aligning Coordinate Systems

There are many ways to align a coordinate system. Coordinate Systems can be aligned by
designating where a horizontal or vertical axis lies; planes can be snapped to geometry; and
planes can be rotated. We will now cover four primary methods of aligning a CS. the first two
items will use the Align Horizontal Axis and Align Vertical Axis buttons. We will then use the
Align CS button for two other methods.

Single Axis Alignment by Manual Input

1. Create anew CS based on CS4 (Highlight 4 and c1ick New CS) and name it Learning.

2. Ensure that all geometry is deselected and c1ick the Align H Axis button. ¢=?->

12



Advanced CS Tutorials

Align H Axis E=l
(71 HY Paint
Foint 1 Foint 2

pane -

e 1
The ' AlignH Axis (or ! V Axis) dialog allows us Y Y
to align the horizontal or vertical axis of the current CS by
using either user input points or to rotate the plane ata bowve
given angle. By default, actions performed by this
function will duplicate and modify the current plane @ HVAngle 30
instead of moving it. Duplicate

2 Times

3. Enter the values shown and Do It.

Two additional planes are created named Learning,
mod (1) and Learning, mod (2).

cs = ES/E

Comment s,

S 307 plane
£ 7 plane
£ Y7 plane
2 7 plane reversed
e | earning
W |earning, mod [1]
- | earning, mod [2]
Al £5

1
2
K]
4
4]
G

Single Axis Alignment Using Geometry

We will now use geometry to align the vertical axis of a CS.

13
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1. Switch to CS5: Learning and hide the markers for CS4, CS6 and CS7 (Double-click the eyes).

2. Create a45° line through the point at the origin.

3. Selectthe line and click the Align V Axis button.

If you are aligning a plane to connected geometry, it is recommended that you select
(D only the line (or two points) you wish to align the axis to. If you select multiple features
(such asDouble-clicking the geometry) the system will align the plane to the lowest

numbered line.

CS5 has been aligned to the 45° line. As a result, the line has also been rotated. Geometry
automatically moves with modifications to a CS. Moving the geometry is the default system

behavior.

This default behavior can be avoided in several
ways. The first and most common is to use an
alternative aligning command by Right-clicking
on an Align button. The default action performed
when clicking on an Align button is the first item,
Align V Axis. For more information on Align, refer to
the Advanced CS User guide, "Align Vertical (V)
Axis” chapter.

Align V Axis

!.r Align V Axis & Move (Alt)

= Create C5 & Align V Axis  (Ctrl)

+f Flip Axis

14
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Another option is to change the default

e coorinete Sysens behavior of new coordinate systems. This
) ’F“i‘la:’“”i”g Prefs New Cs is done through the CS Preferences dialog

. Import/Export [ self Definition which is found in the

poi— [ Geometry References File>Preferences>Coordinate Systems

. Post Processor Comments [Toolpath References dialog. For detailed information on these
) ﬁi.:jj[nugp [ Out of Plane Rotation options, refer to the Advanced CS User

- Post Editor Settings guide, "Coordinate System List Context

... Additive [#]5et New CS Visible

Menu" chapter.

CS Alignment by Rotation Using Geometry

Rotating a coordinate system can be done by specifying a rotation about a specific axis by a
given amount or can be done about geometry. We will start with geometry.

1. Select thisline.

2. Click the Align CS Plane button. A7

Notice how the CS has flipped. A selected line is used to designate the positive direction of the
depth axis. Using the Align CS Plane command with geometry will not move the origin of the CS
but will rotate the CS so its depth axis is aligned to the original position of the line.

CS Alignment by Rotation Using Specific Values

1. Deselect the line.

2. Clickthe Align CS Plane button . TT7

3. Enter the HVD values shown and Do It.

We have specified that the coordinate system is going to be rotated about X0Y0 by 45 degrees in
a clockwise direction using absolute (XYZ) values.

15
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5 Align BEE
A0 Point:
8 %2 ) HVD
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If we had specified the rotation was to use relative (HVD) values, the dialog would have
displayed HO and V0 and the results would look like the image shown.

& Folate
- Angle 45
®* ®H H[D
Yy By & Cw
z@wp Y[0 0w
Dhuplic st o Don

CS Alignment Using Geometry

Geometry used to align a plane may be a set of points, a shape (open or closed), or a
combination of lines and points. Here we will first use a set of points to define the plane’s
alignment, then we will use a closed shape. Please note that if the transformations shown here
do not work then you may need to change your CS Preferences.

1. Switch to CS2: XZ plane.
2. Create points at X100, Z0 and X100, Z100.

3. Selectthe two points as well as the point that lies in the YZ plane.

4. Switch to CS5: Learning and click the Align CS Plane button .

16
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The CS remains essentially unchanged, it has
only rotated 90°. That is because the plane is
already parallel to the selected points. Any
additional clicks on the Align CS Plane button
will continue to rotate the CS by 90° increments.

Undo (Ctrl+Z) the align and Delete the two points we just created.

Inthe YZ plane, create a 20mm square around Y50, Z50.

Switch to CS5: Learning, Double-click the square and c1ick the Align CS Plane
button . sy

The origin of the plane stays in the same
position but the plane swings around to be
parallel to the geometry.

® To move the origin when aligning a CS, one of the move options must be chosen from
the Align CS Plane context menu (right-click).

CS Alignment Using 3D Points

The last CS Alignment exercise will be user-defined 3D points.

Deselect all geometry and c1ick the Align CS Plane button . TI7

2. Enter the values shown, making sure to use the XYZ values and the Move option before

clickingon Do It.

17
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5 Align SE=E
& D Powls

@ ¥Z ) HVD

Fortl % (100 ¥ 100 Zn

Port2 %[0 ¥ 100 Z[am

Forid  ® (100 ¥ D Z[am

o Move

Rolata

Angls

Douplic ate " Dall

The results are an angled plane. the plane aligns to the top-right corner of the XY plane
(X100,Y100,Z20), and the top-left and bottom-right corners (X0, Y100, Z-100 and X100, YO, Z-
100) of the bottom of the part.

®

Because we selected the Move option, the depth origin of
plane was moved to align with those points. If we had not
selected Move, the results of the CS alignment would
look like this image. The plane does align with the points,
but the origin remains where it was.

Existing points can be interrogated ((Alt+click) and (Shift+Alt+click)) tofillin
data but the retrieved data is relative to the current coordinate system. If you want
absolute data be sure to switch to the XY plane, interrogate the points and then switch
back to the coordinate system you are going to modify.

You may now save this part if you wish, but it will not be used in any other tutorials.

3-Axis Part: Angled Webs

In this exercise, we will create a part that has angled webs that require following a 3D contour in
order to machine it properly. The Advanced CS option is necessary to generate this type of toolpath
because the contour that we will be machining lies in a plane other than the standard XY plane.
Creating the contour in another coordinate system allows the system to be able to correctly offset
the tool cutting in Z. We will machine the part from the XY plane. This type of operation can be

18
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created on any contour that lies in a plane that has Z as an axis. Providing that Z is an axis in the
plane, the system can follow a 3D contour, correctly offsetting the tool. For the Part Print for this
exercise, see “Angled Webs” on page 105.

Creating the Angled Webs

About the Part File

There is a pre-existing part file for this exercise.
The file name is Angled webs.vnc and it may be
found in the install directory for the part files or
on your GibbsCAM installation CD. If for some
reason you do not have the part you may re-
create it using the part print.

Creating the XZ Plane

1. Open the file Angled Webs.vnc.

The partis 200 x 200 x 50mm set up on a 3-Axis Vertical Mill MDD. It contains three tools — a
45mm drill, a 13mm Rough endmill and a 45mm rough endmill. There is geometry representing
one set of the open pockets and the thru-hole. There are also pre-generated operations to clear
out the hole and the open pockets. As you can see, there is only one set of geometry for the
open pockets. The Transform Ops plug-in was used to duplicate and rotate the toolpath.

We need to create the contours that will generate the angled webs. In order to do this, we need
to make two additional coordinate systems, the XZ plane and the YZ plane. The web contours
will be drawn in these two planes.

b e
2. Click New CSinthe CS list. :-_—
3. Modify the CS to the XZ plane and rename it XZ plane. XZ

19
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cs [ ey | =)
Cornment
The polarity of the depth axis does not need to be adjusted 1 £ Y plane

because we will be machining these shapes in the XY plane.

Creating the YZ Plane

Two of the web contours need to be defined in the YZ plane to provide for proper machining.

1. Createanew CS by clicking New CSinthe CS list.

2. Modify the CS to the YZ plane and name it YZ plane. YZ

Creating the Geometry

To create the part geometry we will create one profile of the angled web. We will then Duplicate
and 2D Rotate the geometry about the origin.

1. Switch to CS2 XZ plane. Create a new workgroup and create the contour geometry.

From the home view (Ctrl+H) of the
XZ plane, your screen will look like the
screenshot on the left. The home view
always shows the part along the
positive depth axis of the current CS.

The web contour needs to be duplicated in the four locations that need to be cut.

2. Switchto CS1andDouble-click the web contour geometry.

3. Select Modify > Duplicate And 2D Rotate Ij::)-

4. Enter the following.

20
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Dup And GEHS/E DRetate  HEOZE
(") Force Depth... Araund
(70 Mirrar... H o
@ 2dRuotate... v F
(71 &bs Rotate. .
Scale... @ Cw O cow
) Tranzlate... ) :
() Abz Trans... Angle 190
3 tirnes
[[] Visible Wis
Do lk

We have duplicated and rotated the
geometry ata 90° angle, 3 times.

Aligning Geometry to the YZ Plane

1. Switch to the YZ plane.

2. Select the two web contours
shown.

21
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)(YIZ

3. Select Modify > Change CS (XYZ).

By using Change CS (XYZ), the shapes will stay in the same location but will now be drawn in
cyan, rather than magenta, to indicate that they are defined in the current CS.

The geometry and coordinate system creation is complete. For more information on creating the
machining operations, see “3-Axis Part: Angled Webs” on page 38.

4-Axis Part: Slot Block

In this exercise we will create three new coordinate systems. The first CS will be one of the primary
planes, the YZ plane, and the others will be created by rotation using the Align CS dialog. For the
Slot Block Tutorial exercise, see “Slot Block” on page 106.

Creating the Slot block
Part Setup

1. Create a new part with the following stock dimensions:
+X=125,-X=-125, +Y=250,-Y=-250,+Z2=0,-Z=-150.

This part will be machined later in the Machining tutorials. At this point in the tutorial it does not
matter if a specific MDD is used but for consistency, we shall choose one.

2. Selecta 3-Axis Vertical Mill MDD.

Back Profile

1. Switch to the isometric view (Ctrl+I).

e —

2. Openthe CS Dialog ==

3. Attach the CS dialog to the right side of your screen by clicking the docking icon on the dialog.
Now click and drag the title bar, placing the cursor arrow on the grid selection as shown below.
The CS dialog snaps to the outside of the Gibbs screen, keeping the workspace clear.

We will be using the CS dialog extensively during this tutorial.

22



Advanced CS Tutorials

Createa New CS andnameitYZ Plane.

Click the YZ button in the CS palette.

Click the Change CS Origin button.

Enter the information shown and Do it.

8. Switch to the home view (Ctrl+H).

s & [1]=
Comment WO

' m b
YZ
A
Change C5 Origin &= [E
@ vz () HWD
w100 [ Duplicate
| -280
2 12
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When working in the home view, you are viewing the part from a position normal
(perpendicular) to the current coordinate system. Geometry creation can proceed from this
point as if you were working in 2D. The only difference is the labels for the horizontal, vertical
and depth axes (coordinates). In this case, the horizontal axis is labeled as the Y axis, the
vertical axis as the Z axis, and the depth axis as the D axis (not the Y axis because the depth
axis polarity is reversed).

Not only is the orientation of the depth axis important for the machining of the part, but
also many of the solid modeling functions in the system are dependent on the depth
axis, such as extrusions and revolutions.

9. Create the geometry for the YZ Plane.

Because we set the origin in the position that we
did, you should be able to use the dimensions
provided on the blueprint. Remember the origin
acts as a zero reference mark for dimensioning.
Make sure that the D (depth) value in the
geometry dialogs is ©.

10. Switch to the isometric view (Ctrl+I).

Front Profile

Now, we will duplicate the shape along the depth axis.

1. Select the entire closed shape created in the YZ Plane by Double-clickingonit.

2. Select Modify > Duplicate And.... IEI

3. Enter the value shown.
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Dup And =HE = E Force D‘Epth---@ma
@ Force Depth... = |-200

(7 Mirror...
1 2d Rotate. .
() &bz Rotate...

Scale...

F
|
it

(71 Transzlate...

) Abs Trans...

[ Wisible Wiz
Dl

This will duplicate the selected geometry and
move it the specified amount along the depth
axis. We could also have used the Translate
item in the Dup And dialog to accomplish the
same thing.

Right Side Angled Face

Now, we will create the 32° plane that lies on the right side of the part. There are two primary
methods for changing the orientation of a CS to a non-standard plane. You can either select
plane group geometry, which is the minimum amount of geometry necessary to accurately
define a plane, or you can use the Align CS dialog, which allows you to enter specifications to
properly orient the plane. We will use the Align CS dialog to rotate the plane to the correct
orientation.

1. Switchto CS1.

We have switched to CS1 so that the new CS will be a duplicate of the XY plane rather than the
XZ plane.

2. CreateaNew CSandlabelit32 Right.
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G & [1]=
Eu:umm::nt WO
Make sure all geometry is deselected before clicking on 2 £+ Y2 plane
the Align CS button. et W1 plane

-l Fiight

3. Clickthe Align CS button in the CS palette. TT7

The Align CS dialog will appear on the screen. If it does not, you have geometry selected and
the system is attempting to orient the plane according to the selected geometry.

CS Align & [2 =[]
(71 30 Paints
‘LW L ‘ M,‘
@ Fotate
4. SelectRotate and enter the .
information as shown. ] ] Angle |32
|§| u |:_:| H Y
®Z ®D Z 0 @ Cow
[7] Duplicate

The system will modify the new coordinate system
by rotating it from its current orientation, which is
the standard XY plane. In this case, the CS will be
rotated 32° about the X axis in a counterclockwise
direction. The location of the X axis which will be
rotated about is determined by the values entered
inthe Y and Z text boxes.

The planar orientation of the coordinate system will change, but the origin will not be affected.

To further modify the new CS to properly create the slot geometry, we will need to change the
origin.

We can change the origin of a CS by entering coordinates in the Change CS Origin dialog, which
is how we modified the last CS. Another method for changing the origin is to select an existing
point and c1lick the Change CS Origin button. This action will cause the selected point to become
the new origin for the CS. In this case, we will select an existing point to change the origin.
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5. Select the point shown and click the Change CS Origin button . Al

6. Switch to the home view (Ctrl+H).

In order to get an idea of the orientation of the part, look at the trackball [ ﬁ (
in the center of the View Control palette.

This gives you an indication of the view at which you are looking at the part and also the
orientation the part will be in when it is machined.

7. Create the slot geometry.
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The labels in all of the geometry dialogs
should read H for the Horizontal axis, V for the
Vertical axis and D for the Depth axis as none
of the axes in the current coordinate system
align with the primary X, Y and Z axes. Make
sure the CS grid and axis markers are drawn
on the screen so you can keep in mind how
the part dimensions should be entered.

8. Switch to the isometric view (Ctrl+I).

Left Side Angled Face

Now, we will create the 32° plane on the left side of the part.

Make sure that the current CS is the 32 Right plane so that the new CS is a duplicate of that
plane.

1. CreateaNew CSandnameit32 Left.
2. Open the Align CS dialog. 7
5 Align EHE=E
() 30 Points
DGl gl e o aimas 4
@ Raotate
3. Enter the information shown. s tnale 64
@ 4 |:::| H Y0
|:::| e |:::| W I:é:l s
®Z ®D Z 0 o) oW
[ Duplicate
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We have rotated the current CS a total of
64°. A 32° rotation would have oriented the
plane so that it were parallel to the XY plane.
The additional 32° places it in the proper
orientation for the left side of the part.

4. Selectthe point shown and change the CS origin.

It may be difficult to see the labels on the axis markers in the current view and specifically to tell
the polarity of the depth axis (indicated by the “+” or “-” sign on the axis markers).

5. Ensure that you are in CS4, the 32 Left plane.

6. Selectthe right hand slot geometry and duplicate it.

7. Select Modify > Change CS (HVD). HvD

This moves the geometry around to the new CS and the arcs are not converted to splines, which
can happen when performing certain modifications to geometry.

Mirror = [E=E

Walues Ta Miror

Iy o
8. Mirror the slot geometry about VO. Wi |0

[z |0

[ Wisible 'WiGs Dol
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The final part geometry will look like this.

5-Axis Part: Hinge

In this exercise, we will create four coordinate systems, using a normal vector to define one of the
planes. For the Hinge part print for this exercise, see “Hinge” on page 107.

Hinge Set Up

Part Dimensions and Machine Type

» Create anew partHinge. vnc with the following stock dimensions:
+X=150,-X=0,+Y=75,-Y=0,+Z=0,-Z = -90.

e Select a5 Axis Horizontal Mill for the Machine.

We will not go into the rotary setup for the part in this section. For a more detailed description of
rotary setup, see “Rotary Setup” on page 48.

Creating the Hinge
Top and Bottom Geometry

The first thing we will create is the part’s top profile. We will then duplicate the geometry and
change its depth to create the bottom profile.

1. Create the top view geometry in the XY
plane.

The top view geometry we want to create
is the rounded contour.

Now, we will duplicate this shape to create the back side geometry for the hinge.
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2. Select the entire contour then Dup And Translate the shape to a depth of Z-90.

3. Switch to the isometric view (Ctrl+I).

Back Side CS Creation

We will now create a new CS in preparation for the machining of this part. When creating
machining operations, the tool approaches and cuts the part along the positive depth axis of the
CS selected as the Machining CS. The standard XY plane does not have the depth axis in the
correct position to machine the back side of the part.

1. Createanew CS and nameitXY back side.
This will be an exact duplicate of the XY plane, which is the correct orientation. We simply need

to change the origin and toggle the depth axis.

Assigning the Back Side Geometry

1. Select the point shown and c1ick the Change CS Origin
button.

2. Click the Toggle Depth button . g

Clicking the Toggle Depth button will flip the depth axis which also has the effect of inverting
the horizontal axis. Any rotations of the coordinate system axes, follow the Right Hand Rule.
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Notice that from this view, you see a “-” sign on the axis markers indicating that you are viewing
the part along the negative direction of the depth axis. Use the home view and the trackball to
get an idea of the orientation of the CS and the part.

You will notice that both shapes are magenta. This indicates that these shapes were created in
a different coordinate system.

3. Select the entire shape that was just moved and select Modify > Change CS (XYZ).

X YIZ
--

This shape should now be drawn in blue on the
screen, indicating that it was created based on the
current coordinate system. The Change CS (XYZ)
function assigns all selected geometry to the
current coordinate system. The geometry stays in
the same location in 3D space in which it was
created.

Center Wall Creation

We will now create a new workgroup the geometry for the angled center wall. This geometry will
be created in the standard XY Plane, CS1. You can display the coordinate system list by
clicking the Coordinate system list down arrow button.

u_

A
TL_

Coord 5 Palette
Systems

1. Create a new workgroup and switch to the XY Plane. 1: XV plane

2: XY back side

u_
= Mew Coordinate System
g o

2. Create the center wall geometry.
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You do not need to worry about creating
the geometry at the appropriate depth
because we can use Modify > Force Depth
or Modify > Translate.

Note that it is not necessary to draw the
entire shape that is shown in order to
properly program this part. However, we
are drawing this for visualization purposes.

3. Use Modify > Translate or Force Depth to place this shape at a depth of Z: -38 and I}I
Z: -52mm. tl Ll

4. Cutand paste this geometry into
WGH.

Pocket Geometry CS

We will now create geometry for a pocket in the XZ plane. The pocket will create the separation
of the two sides of the hinge. In order to make the geometry we need a new coordinate system.

1. Createanew CS named XZ top side.

2. Align the new CS to the XZ plane. 7

We will modify this new CS to be flush with the top of the part, with its vertical axis aligned to the
front profile geometry.
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o
3. Switchto WG1 and align the CS origin to the point shown.

4. Toggle Depth axis . Zjﬂ'

The CS should now be aligned to the Y+ side of the part. To correctly orient the axes of this
coordinate system, we will use the Align Vertical Axis button.

_._i.,

5. Align Vertical Axis tothe line

shown.

This will rotate the axis markers so that the vertical axis aligns with the selected line.

6. Make sure the line is still selected and c1ick the Align Vertical Axis button again. _!_i.,
|

7. Switch to the home view (Ctrl+H).
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Our plane is now correctly oriented.

@ Once an axis has been aligned, additional c1icks on the Align Axes buttons with
geometry selected will flip the alternate axis 180°.

Pocket Geometry Creation

1. Create the pocket geometry as shown.

The pocket geometry should be flush with the end of the part. The line that is on the edge of the
part should be designated as “Air” geometry so that when we machine the geometry, the tool
will overlap the geometry, creating an open pocket.

At this point, you will have three coordinate systems and two workgroups. Separating geometry
into different workgroups is not necessary; however, it often simplifies geometry creation.

Angled Hole CS Creation

To complete the part, we need to create one more CS for the hole on the angled wall.

1. Create anew CS based on CS3 named Hole.

We will use a normal vector to correctly orient this plane. Normal vectors are perpendicular to
the plane.
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2. Select the line shown which is the normal vector to the CS we
wish to create.

3. Clickthe Align CS button.

The Align CS button will attempt to align the plane through the selected geometry. In the case
where not enough geometry is selected to accurately orient the plane, the system will attempt to
align the plane normal to the selected geometry which is what we have done in this case. The
modified CS will be perpendicular to the line we selected.

4. Select the point shown.

The point is the vertex of the 90° angle on the center wall.

5. Clickthe Change CS Origin button .

==
1
+
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The screenshot on the right shows the correct placement and
orientation of the plane in the top view. The plane should be
correctly oriented with the positive depth axis pointing out
indicated by a “+” sign at the center of the axis markers. If itis
not, toggle the depth.

6. Switch tothe home view (Ctrl+H).
7. Create the circle for the drill hole.
The geometry for this part is now complete.

8. Save thisfile (Hinge.vnc) as it will be machined in the Machining section.
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MACHINING CS’S

This chapter describes the uses of the Advanced CS option with a 3-axis, 4-axis, and 5-axis
machine. The parts described in this chapter require the creation of multiple coordinate systems to
properly define the part geometry and provide for accurate posted output. Multiple part
programming and tombstone programming will also be covered.

This chapter is divided into two sections. Parts in both sections use multiple coordinate systems for
machining and do not involve rotary positioning.

In the first section, all of the parts are created using a 3-axis Machine Type and are posted with a
Standard Mill Post Processor. Coordinate systems are used to define part geometry in the
appropriate locations. Once that is done, the parts are programmed with the system as they would
be, using the Production Mill Module.

The second section uses coordinate systems to utilize work fixture offsets for machining multiple
parts and/or multiple sides of parts in one program. These examples require an Advanced CS Post
Processor to produce the appropriate posted output which uses G55, G56, etc. for the work fixture
offsets. These exercises can be programmed to run on a 3-axis milling machine and use the
standard XY plane for all of the machining operations. However, an Advanced CS Post Processor
is required to use work fixture offsets.

» 3-Axis Part: Angled Webs
* 4-Axis Part: Slot Block
* 5-Axis Part: Hinge

3-Axis Part: Angled Webs

This exercise illustrates that contours that are defined in any Z plane (a plane where Z is an axis)
can be machined from the XY plane. This part will be machined with a 3-axis mill.

About the Part

For the detailed description of the geometry and coordinate system
creation for this part, see “3-Axis Part: Angled Webs” on page 18.
The part is created using a 3-Axis Vertical Mill MDD. Some of the
machining operations for this part are pre-generated and all of the
required tools are already in the tool list. This includes a 45mm Dirrill,
a 13mm Rough Endmill and a 45mm Rough Endmill.

Machining the Angled Webs

The First Contour Process

The only area that remains to be cut are the four webs to create the angled walls. Thus far all of the
machining operations could have been done with a standard mill. The operations we need to create
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to cut the webs will follow the contours we created in the XZ and YZ planes.

Contour | Mil Featre | Solds | Open sides| offset | Entryjext |

Material (O Depths from Feature
(®) Depths From Tool
st
amree] ] ‘01 M [
Contour Feed ] [Repid 1n 9 nw o
Entry And Exit N W‘ﬂ.‘
@Lme 0 i N
i 0
90° Radius .
Os0°Line Desired Actual # Passes
O Advanced D 0 1
No. of Extra Offsets | 0 [JRetracts  [“IDepthFirst [] Prefer Subs
" . [Jramp Down []Back &Forth
1. Open the file Angled Webs and create this Sorthi s 5
. Stock 0
Contour process with tool #3. o]
ZStock 0 e o
Overlap o [“]Round Corners Break D
Spring Passes 0 [ Cutter Radius Comp. On
[Juse Stock ] Coolant
Material Only Iz Flood
Ignore Prior Tool Profiles
[Jrattern: 1: Workgroup
Mach. CS: 1: XY plane
Comment ‘ ‘

Notice that the Floor Z value is 0. This way the toolpath will follow the contour and the depth of
cut will be determined by the selected contour. The Floor Z value in the process dialog controls
the depth value in reference to the geometry’s coordinate system. The value of 0 is good to use
if the geometry is at a depth of 0 in the CS and the CS is in the correct position. Also, the
Machining CS is the XY plane, not the plane that the contour was defined in. All of the web
contours will be machined from the XY plane.

2. Select the web contour from CS1 as
shown.

3. Clickthe Do It button or use
(Ctrl+.).

The screenshot is displayed from
the Front view. The current CS is
the XY plane.
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4. Deselect the operation and repeat the process
for the other three webs as shown.

The information in the Contour process data remains exactly the same. Simply select the cut
shapes and properly position the machining markers.

5. Render the contour operations. W

The partis now complete.
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4-Axis Part: Slot Block
Defining the Slot Block

For a recap of the coordinate system construction and
geometry creation for this exercise, see “4-Axis Part:
Slot Block” on page 22. In this exercise we will pocket
the center of the part and we will face mill and pocket
both of the 32° coordinate systems. For the Slot Block
part print for this exercise, see “Slot Block” on

page 106.

Setting Up the Slot Block

In order to face mill and pocket the two 32° planes we need a machine with a rotary axis. We will
machine this part on a 4 Axis Vertical Mill. While there are several ways this could be set up, we
will create the part as if it were mounted to the machine on a fixture plate. This is illustrated in the

above image. The part is shown inside a transparent stock body which is mounted to the fixture
plate.

1. Open the Slot Block.vnc file.

3 Az Wertical Mill

4 Ayiz Wertical Mill

2. Open the Document Control dialog and select the 4 Axis |5 auis vertical Mil

Vertical Mill MDD. 3 Ais Horizantal Mill
4 Axiz Horizontal Mill

-

3. Adjust the stock values to X+100, -100, Y+250, -2580,
Z+ 0, -125. Set the Clearance Plane to 25mm.
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Rotate Around
@ X ¥ o0 i
2 o L~
4. Click the Machine ©z
Setup tab and enter the [+ ’
information shown. [ Auds Limited
Min. Limit
Max. Limit

This specifies that the point of rotation is the part origin. This would require that the part be
carefully positioned on the fixture plate such that Z0 is actually at the center of rotation.

Machining The Slot Block
Tool Definition

We will use only two tools to machine this part, a Face Milland a Rough Endmill.

Straight Shank

Straight Shank

{

1. Create a Face mill with a 100mm diameter and a 50mm flute length. This is a flat bottomed tool.

2. Create arEM with a 25mm diameter. This is also a flat bottomed tool.
Center Pocket Geometry

The first operation we will create will be a pocketing operation to rough out the center portion of
the block. In order to do this we will need to create the pocket geometry.
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1. Create 200x140mm rectangle at the origin
in the XY plane. Define the left and right
sides of the rectangle as “Air” geometry so
that we can easily machine this open
pocket.

Notice the smaller sides of the rectangle are
designated as “Air” geometry so that the
pocketing routine will remove all of the
necessary material.

Operation 1, Pocketing the Middle

1. Create this Roughing process with the
Rough Endmill.

v

Pocket| Ml Festure | Soids | Open Sides| Offset/Trim| Entry/Exit Rotate |

Mach CS: | 1: XY plane ~

e 41|

() Polar and Cylindrical Miling

(®) Positions

Duplicate
o Jmeo
o R

Pocket | Vil Feature | Soids | Open Sides| Offset/Trim| Entry/Exit | Rotate |

Offset - (O Depths from Feature

e (®) Depths From Tool
i [ R EE ) IER
Ri In
e e —

— e

s[5 |

Entry And Exit 7 Step

OLine Desired Actual # Passes

90 Radius s N

®90°Line D [FRetracts (A Depth First [Prefer Subs
O Advanced Do not hit flats ~
ST —

BendSwckx [0 |

ot [T ]

Overlap 0 | [ HRomicomes  mesk [0 |
SoringP D [Jcrcon [~ Climb

asses
e [] Coolant
Flood
[Juse stock [Pattemn: 1: Workgroup
Material Only
Ignore Prior Tool Profiles
Outermost Shape As Boss
Comment ‘
rale,

Pocket| Mil Festre | Soids Open Sides | Offset/Trim | Entry/Ext | Rotate|
Overhang

-
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2. Inthe Rotate tab ensure that the Mach CS is set to the XY plane. The Open Sides data does not
need to be changed, the default values are adequate.

3. Select the pocket geometry
and create the operation.

Operations 2 and 3, 32° Right Face

We will now create operations to face mill and pocket the 32° planes.
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1. Create this Roughing process with the
Face Mill.

Po-cloetl Mill Feature | Solids | Open Sides] Offset,’Triml Entry/Exit ]Rnhtel

Face Miling v (O Depths from Feature
‘ — (® Depths From Tool
e v @ [e
Entry Feed 3 DRaden A 0
— i -
Cut Width 50
ZStock ZStep
® El Desired Actual #Passes
Stock Start Corner
33 325 2
Ostere s O
@spiraln @x @V [JRetracts [“IDepth First [ Prefer Subs
istCut

Ozgzag Clearance
(OBack &Forth ©’f* Ov+
O 1Direction x- OV
[ Cut Above Stock
CIRall n Entry [JRround Corners

] Coolant

[ Floed

[Orattern: | 1: Workgroup v

We have designated a material height of 65mm because the stock material is well above Z0.
This will ensure we do not violate the part. The actual stock extends to a little more than 63mm

above Z0.

2. Setthe Mach CS option in the Rotate tab to
32 Right.

Because the face milling roughing option
allows you to face off the entire stock, we
can combine the pocketing operation with
the roughing operation in the same Process
list.

Pochet] Mill Feature | Solids | Open Sldes] Offset,’TrimI Entry/Exit ml

Mach cs: | 3: 32 Right v|
(®) Positions Angle A D
(O Polar and Cylindrical Miling
Duplicate
T Jweo
sl ]
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Pocket | willFeature | Soids | Open Sides| Offset/Trim| Entry/Exit | Rotate|
Offset ~ (O Depths from Feature
- @DepthsFranuol
Material
Speciiion | [ 15 ERN ) IR
ewyreed | (B e il
e Oy .| e
Cut Width 12.5
Entry And Exit ZStep
OlLine Desired Actual #Passes
3. Create this Roughing process with the o Rodhus 25 2
Rough Endmlll ®30°Line U—| [Jretracts  []Depth First []Prefer Subs
O Advanced ; Do not hit flats v
The settings in the Rotate tab do not need to rdetsos [0 | e 0
be checked. Simply setting this option once '“:‘;S“‘* : %
. . . zs
in a process will affect all other processes in o [0 | ORwmdcomes ek 0|
i [Ccrco [ climb
the |ISt Spring Passes 0 E Coolar:\t m
Flood
[CJuse Stock [Jrattern: 1: Workgroup
Material Only
Ignore Prior Tool Profiles
Qutermost Shape As Boss
Comment

4. Selectthe slot geometry and create the operation for the slot.

Don't forget to deselect the previous operation before creating this toolpath.

5. Render the part.

Operations 4 and 5, 32° Left Face

Now, we will machine the other 32° plane. We can use the same process group to machine the
other side.

1. Deselect the operation tiles.
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Pockct] Mill Feature | Solids | Open Sides| offset,tTrimI Entry/Exit Wtﬂl
Mach CS: | 4 32Left ~
2. Change the Mach CS in the Rotate tab to 32 ®postions age a0 |
Left (O Polar and Cylindrical Miling
Duplicate
0 | time(s)
Al ]

All the other information in process dialogs should remain the same. The other processes in the
group will all change their CS’s as well.

3. Select the other slot geometry for the left side and create the toolpath.
4. Render the part.
Note that you did not have to switch coordinate systems.

All of the operations to cut the part have been created.

5-Axis Part: Hinge
About the Hinge Part

To see the coordinate system construction and geometry creation for this exercise, see “5-Axis
Part: Hinge” on page 30. For the part print for the exercise, see “Hinge” on page 107.
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Setting up the Hinge

1. Open the Hinge.vnc partfile.

You may recall that the part is 150x75x90mm (X+150 X-0, Y+75, Y-0, Z+0 Z-90. This part will
be programmed for a 5 Axis Horizontal Mill. The part is gripped from the front (Y-side). In another
situation we would probably leave more material on the Y- side of the part so that the part can be
cut off, but for greater visualization of the part we are not including the extra material that would

get cut off.

Rotary Setup

1. Open the Document Control dialog.

| General | Comments | Machining Preferences | Machine Setup

4h fxis (part)

2. Clickthe Rotary Setup button and | °

B+
enter the information in the 5 Axis Setup ) s L

Min. Limit

dialog as shown. M. Lt

5th Ads

Rotate Around

@ X

®Y

®z

+

s Limited
Min. Limit 5
Max. Limit 95

The part is oriented so that the 4th axis is centered in X and Z while the 5th axis is centered in Z

and 75mm below the bottom of part.

3. Setthe part’s Clearance Plane to 120mm.

Itis a little more than 106mm from bottom-center of the part (where the machine will rotate) to a

top corner. 120mm will give us adequate clearance when the part moves.
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Tool Creation

1. Create the following tool list:

Total # Flute

# Type Length Diameter Corner/Tip Flutes Length Material
1 rEM 75mm  75mm  13mm 2 50mm oS TN
Coated
2 rEM 100mm 26mm  Omm 2 gomm HSSTN
Coated
3  Shell 75mm 50mm Omm 4 50mm HSSTIN
Coated
4  Dirill 75mm  8mm 118° 2 N/A HSS

Machining The Hinge

Operation 1

The first operation will contour the front side of the part. We will use the rough endmill with the
13mm bottom corner radius to create the necessary fillet.

Contour | Mil Feature | Solds | Open Sides| offset | Entry/exit | Rotate |
Material (O Depths from Feature
(® Depths From Tool
e
Gyresd | [om |t i t
Contour Feed 0.24 ERapdin e
el B Ak
@ Line 38 -
90° Radius 0
. . Z Step
1. Create this Contour process with tool #1. Os0°Le Desred Acuel  #Passes
O Advanced 19 2
The cut depth of -38mm will cut to the center No. of Extra Offsets |0 Llrevacts  EDepth st [lPrefer subs
. . e [Jramp Down []Back &Forth
wall of the part. With an Entry Move and Exit ' p———— -
Move of 38mm the tool will plunge down, off o L]
. . . 7 Stodk 0 Auto Plunge ~
of the part by just more than its radius, then — 0] vomtcones  sex [
feed into the part. We do not need to enter spingPasses [0 | [ cutter Radus Comp. On
any data in the Open Sides or Rotate tabs. Cluse stock g;“':“
Material Only a0
Ignore Prior Tool Profiles
[rattern: | 1 Workgroup
Comment
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Select the cut shape by positioning the
machining markers as shown.

The start and end point markers are placed
on the connecting points at the edge of the

part.

3. Clickthe Do It button or use
(Ctrl+.).

Operation 2

Next, we will contour the other portion of the front side profile.
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Contour | il Feature | Soids | Open Sides| Offset| Entry/Exit | Rotate|

Material (O Depths from Feature
(®) Depths From Tool
—
Gyred| [ ] * ENNE ) N ER
e 7| D f EXTS
Entry And Exit 0 ~ 7 + _
@ Line u .
90° Radius 5 25
(O90°Line Desired Actual # Passes
1. Create this Contour process with tool #2. O Advanced 19
No. of Extra Offsets |0 [Retracts  [“IDepth First [~] Prefer Subs
Note that we have a line and radius value [ Ramp Donn [Back &Forth
. . . Stock & E Do not hit flats ~
applied to the entry and exit moves. Again,
. . tock 0 ~
we do not need to set anything in the Open - % é"“’""“
. ver Round Corners Break
Sides or Rotate tabs. svoremes [0 ] Ecumrascom. ]
[Juse stock [] Coolant
Material Only E Flood

Ignore Prior Tool Profiles

[rattern: 1: Workgroup

Comment

2. Select the cut shape by positioning the
machining markers as shown.
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3. Clickthe Do It button or use
(Ctrl+.).

4. Render the operations.

Now, we will contour the back side of the part. The processes will be identical to the first two
operations, except for the machining CS and the selected cut shape.

Operation 3

1. Switch to the XY back side CS.
2. Change to the home view (Ctrl+H).

3. Double-click operation #1to reload it.

Contonrl Wil Feature | Solids | Openﬁlles‘ Oﬁ’setl Entry/Exit Rnhnal

Mach CS: | 2: XY back side ~

4. Open the process dialog and change the
Mach CS in the Rotate tab to XY back side.
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You will notice that the only available item on this tab is the Machining CS. This is because the the
setup in the DCD for 5-axis makes it so that the rotary axis is shifted off the part origin.

5. Select the cut shape by positioning the
machining markers as shown.

6. Clickthe Do It button. o

Operation 4

As with Operation 3, the information in the process dialog for this operation is the same as for
operation #2, except that the Machining CS must be set to the XY back side CS.

1. Double-click operation #2 to reload it.

Open the process dialog and change the Mach CS in the Rotate tab to XY back side.
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3. Select the cut shape by positioning the
machining markers as shown.

4. Click the Do It button.

5. Render the part.

Operation 5

The next operation will pocket out the top side of the part.
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1. Switchtothe CS, XZ top side.

Pocket | milFeature | Solds | Open Sides| offset/Trim| Entry/Exit | Rotate|

(O Depths from Feature
e (®) Depths From Tool

g [ S ERE ) EERERL
| EntryFee 6L Orapdin AL o
contourFeed|  [0.61 0 ) -

Offset

1 <

Cut Width 13
Entry And Exit 25tep
OlLine Desired Actual #Passes

90° Radius

®90°Line D [Retracts ~ [ZDepth First []Prefer Subs
; . . O Advanced [Donothitfats |
2. Create this Roughing process with tool I L e
#2. BandSwcks [0 |
o [
Overlap IZ' [ Round Corners Break D
o =
[ Coolant
[ Flood
[use stock [rattem: | 1 Workaroup v
Material Only

Ignore Prior Tool Profiles
Qutermost Shape As Boss
Comment

Pocket| MiFeature | Soics | Open Sides| Offset/Trim| Entry/Exit Rotate |

MachCs: | 3:XZ top side v
(®) Positions Angle

3. Setthe Mach CS to XZ top side. g
Duplicate

l:l time(s)
3 O

4. Selectthe pocket geometry, click the Do It button or use (Ctrl+.) and render the operations.
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Operation 6

In order to complete the part, we must generate operations to create the angle on the center
wall and drill the hole.

1. Switch to CS4: Hole and change to the home view (Ctrl+H).

First, we need to create a line in this CS so that we can create a contouring operation which will
create the angled wall.

2. Create a horizontal line at V=0.

The line should be terminated at each end so that we can
position the start and end point machining markers.
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3. Create this Contour process with tool
#3.

4. Select Hole as the Mach CS.

The 25mm line gives us room for the tool to
feed onto and off of the part. The Surface Z
value of 39.05102mm is acquired by
interrogating any of four points.

Contour | wilFeature | Soids | Open Sides| oOffset| Entry/Exit | Rotate|

Material

I

Speed: RPM
Entry Feed

[ g
=)
~

Contour Feed
Entry And Exit

(O Depths from Feature
(®) Depths From Tool

R ) BN

[JRapid In AR 0°
39.05102 | + D

@ Line
90° Radius
O 50°Line
(O Advanced
No. of Extra Offsets
a Stepover
Stock £
2 Stock

Overlap

T [T7H

Spring Passes

[ use stock
Material Only

Ignore Prior Tool Profiles

Z5tep
Desired Actual # Passes

9.76276 4

[Jretracts  [“]Depth First [~ Prefer Subs
[JRamp Down []Back &Forth
Do not hit flats v

Auto Plunge ~

[ Round Corners Break D

[ cutter Radius Comp. On
[ Coolant

[ Floed

Contour| MilFeatre | Soids | Open Sides| offset| EntryExit Rotate

Mach Cs: | 4: Hole

~

@ Positions Ange B D

() Polar and Cylindrical Milling

Duplicate

I:l time(s)
3 I
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5. Selectthe new line and position the machining
markers as shown.

6. Click the Do It button.

7. Render the operation.
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Operation 7

The final operation drills the hole in the angled wall.

1. Create this Holes process with tool
#4.

L)y
Drill I Hole Feature | Bore | Pre-Mil | MilFeature | Rotate|
Entry/Exit Cyde: (O Dimension from Hole
(OFeed In - Rapid Out (®) Dimension from Tool
(@) Feed In - Feed Qut AtOp End
OTap 13 R 0 3 1
ORigid Tap
(O Pedk, Full Out & 8
(O Peck, Chip Breaker -50
(O Rough Mill Bare 0 ] -+
-52.40344
(O Finish Mil Bore [—l :l
(O Helix Bore
O |Bore
Load H1D
Transition Between Holes
Material @R Level 3
REM 167 (O Part dearance 120
(O Absolute Z
Feed 347
(OHole Feature
Dwell 0
_ [~] vary Depth With Geo.
[JRreverse Order
[ Coolant
[A Flood
[ 1 Direction
[rattern: 1: Workgroup
Comment

2. Select Hole as the Mach CS as the machining CS.
A full diameter depth of -50mm will drive the tool through the left side of the part.
3. Selectthe geometry for the hole and c1ick the Do It button or use (Ctrl+.).

All the operations to program the part have now been completed.
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4. Render the operations.

Note that the hole goes through the left side of the part.

Normally, fourth and fifth axis rotary parts are processed using a C-style post processor so that
the rotations are output in the code, rather than as a WFO. An example of the output is shown
here.

PostEditor - ¥\ Users\Angie0'\ Documents' Gibbs sample partsiAdvanced C5\Hinge CoEplek

Lond Fie | |Matws B
i NAIG1TGA0GED
Save Fie | [N42T
MNe4LE
{ OPERATION 3 CONTOUR )
{ WORKGROUR )
[ TOOL 1: 75. ROUGH ENDMILL )
[ CS#2 - X¥ BACK SIDE )
| G55 = X380 ¥0_Z0. )
NasGEs
HAESZ20M3
MHATGORGE0N-952 52870 240 8180
NABG4IZI04E H1
oK NABME
NEZTE 2
MHo1G1Z-482 6F6. 066
MEZWSES
NS3IG1X-952 5Y2870.2
NS4Z-965 2F8 096
NEELGER?
HEEGOZTE.2
HSTHE
MSBEGE1GZEZD
NS5
MG 1
NE1G1TG406G0
HE2T2
MEING

T e s

—+

m

TIEAT

5. Save this part.
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WORK FIXTURE OFFSETS

We have seen how multiple coordinate systems allow us to manipulate the part and machine it.
Another use for multiple coordinate systems is to utilize work fixture offsets (WFO) to machine
multiple coordinate systems and/or multiple sides of parts in a single program. In order to use work
fixture offsets, parts must be post processed with an Advanced CS Post Processor, typically a B-
Style post.

This chapter contains two exercises which use WFOs. The first creates two parts, a left and right,
and machines them using WFOs. The second exercise machines the top and bottom sides of a part
in a single program.

When using work fixture offsets, the system matches each coordinate system with a WFO. This is
done in the order of the coordinate systems in the CS list dialog. CS1 is always WFO 1 (G54); CS2
is always WFO 2 (G55); CS3 is WFO 3 (G56); etc. This can be overridden by specifyinga WFO
number in the CS list. For more information on WFOs, refer to the Advanced CS User guide,
"Rotary Tables/ Work Fixture Offsets" chapter. By assigning a specific WFO number to a CS you
can more easily create and modify your part.

Family of Parts

In this exercise, we will create geometry for the left side of a part, mirror the geometry to create the
right side of the part, and then machine both parts in a single program using different machining
coordinate systems for work fixture offsets. The left side will be done in G54 and the right side in
G55. For the part print for this exercise, see “Family of Parts” on page 108.

Making the Model
Part Setup
+# 625 -

1. Create a new metric part with a 3 Axis *L 3
Vertical Mill MDD with the dimensions as X |15 - |
shown and a Clearance Plane value of -
15mm. s 125 |

s Z £5
-f 275

Tool Definition

1. Create the following tool list:
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Total . . # Flute .
# Type Length Diameter  Corner/Tip o, . Length Material
1 FaceMil 63mm  160mm  1mm 5 15.5mm HOS TiN
Coated
2 fEM 166mm  25mm  Omm 3 9omm  HSSTN
Coated
Rough HSS TiN
3 EM 123mm  16mm Omm 3 63mm Conted
4 Dril 100mm  40mm  118° 2 N/A HSS TN
Coated
5 fEM 123mm  16mm  Omm 3 63mm  1SSTN
Coated

Geometry Creation

1. Create the part geometry with the center of
the D-hole at the origin.

You only need to create the outer profile of
the walls for the part, but you will also need
to create the inner profile of the exterior wall
for machining. The Plug-ins > Create DHole
will create the D-hole but remember to add
the radius to the flat diameter (125) to get the
proper flat distance.

To create the geometry for the right side of the part, we will duplicate and mirror the left side
geometry.

2. Selectall (Ctrl+A) of the geometry.

3. Choose Modify > Duplicate And... Mirror the
geometry about the X axis at 250mm.

G55 Coordinate System

Now, we will create a new coordinate system for the right side of the part.

1. Create anew CS and name it G55.
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Select the point shown and click the Change CS Origin
button.

(Shift+drag) to select the mirrored geometry
and choose Modify > Change CS (XYZ).

The geometry will remain in the same location,
however it is now defined in CS2 and is drawn
in blue and yellow rather than magenta,
indicating that it is based on a different
coordinate system.

Machining the Part

The geometry and coordinate system creation is complete. Now, we will create machining
operations to cut both sides of the part.

Face Mill

First, we will create an operation to face mill the top of the part. We will face off the entire stock in
one operations which will encompass both sides of the part.

Switchto CS1.
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Pocket | Ml Feature | Soids | Open Sides| offset/Trim | ntry/exit |
Face Miling " (O Depths from Feature
— (® Depths From Tool
— SER ) B
EnryFeed | [197 | [Repid 1n g o
Contour Feed 1097 IS—‘_ - El
Cut Width N
ZStock 0 ZStep
(® Stock Start Corner Pesred A;lual #-Passes
(O shape @x+ @r+
Ospralin Ox- Ov- [Jretracts  [“]DepthFirst []Prefer Subs
2. Create this Roughing process with tool Ozgzag — Cearance
OBack &Forth + Ors
#1 . (®) 1 Direction @®@x- Or-
[ cut Above Stock
CJrol nEntry [Jround Corners
[ Coolant
[ Flood
[Jrattern: 1: Workgroup
Mach. Cs: 1: XY plane v
Comment

3. Clickthe Do it button.

Deep Pockets

Next, we will create operations to pocket out the D-hole and slot. We will use separate process
groups for each side of the part. This allows us to set a different machining CS (G55) for the
right side operations. In the posted output, the left side operations will use G54 and the right side
operations will use G55. The work fixture offsets will contain the origin shifts for each coordinate

system.

64



Work Fixture Offsets

Pocket | il Feature | Soics | Open Sides| Offset/Trim | Entry/Exit |
Offset ~ (O Depths from Feature
e (®) Depths From Tool
Y R ) BN
eniy e S NI
- [Ny, e
Cut Width [25 ]
Entry And Exit 7 Step
OlLine Desired Actual # Passes
90° Radius 10 3
X X . ®90°Line : [Retracts  [“IpepthFirst []Prefer subs
1. Create this Roughing process with tool #2. O advanced Do nothit flats z
) Pocket Stock = D o S
Make sure that the Mach CS is set to the XY landsods [0 |
p lane. 2 stock D
Overlap I:l [AIround Corners Break D
- D [CJcrcon M cimb
Spring Passes ] Coolant
[ Flood
[l use Stock [eattern: 1: Workgroup
bMaterial Only Mach. CS: 1: XY plane v
[ 1gnore Prior Tool Profiles T :
[[J outermost Shape As Boss
Comment

2. Selectthe D-hole and slot geometry on the left side part and c1ick the Do it button. o

Deep Pockets - G55

The same process can be used for the right side pockets.
Make sure the operation tiles are deselected in the Operations list.
1. Change the Mach CS to G55.

2. Selectthe D-hole and slot geometry on the right side part and c1ick the Do it button.
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Contour

Next, we will create operations to contour the outside profile of each part.

1. Create this Contour process with tool
#2.

2. Position the machining markers as
shown.

Material

Speed: RPM
Entry Feed 16!

4

Contour Feed
Entry And Exit

Contour | wilFeature | Soids | Open Sides| oOffset| Entry/Exit |

(O Depths from Feature
(®) Depths From Tool

e Y [

[OJrapid in AF 0°
o 1 =]

(® Line
90° Radius
(0 90°Line
(O Advanced
No. of Extra Offsets
a Stepover
Stock £
Z Stock

Overlap

T [

Spring Passes

[ use Stock
Material Only
Ignore Prior Tool Profiles

ZStep
Desired Actual # Passes

13.75 4

[JRetracts  [“]Depth First []Prefer Subs
[Jramp Down [Back &Forth
Do not hit flats v

Auto Plunge ~

[ Round Corners Break D

[ cutter Radius Comp. On
[ Coolant

[ Floed

Contour| MilFeatwre | Soids | Open Sides| Offset Entry/Exit

Entry And Exit
@ Line

B
20°Radius D 90° Radius

Oexit

Line
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3. Clickthe Do It button. o

Contour G55

1. Use the same Contour process with G55 selected for the Mach CS. Select the outside contour of
the right side part for the cut shape. C1ick the Do it button.

The cut part rendered image should look
like the image to the right.

Thus far we have created the operations in the relative order that we want them to be machined.
We have alternated between machining the left side and right side, using G54 and G55, to
minimize the tool changes. Another method would be to create all the operations to machine the
left side part and then create the operations to machine the right side. Once all of the Operation
tiles have been created in the Operations list, they can easily be arranged into optimal order for
the most efficient machining.

For the remainder of the exercise, instruction will only be given on creating the operations to
machine the left side of the part. When you’ve created the left side operations, use the same
process information to create the operations for the right side of the part. Just remember that
you need to change the Mach CS to the G55 coordinate system in the process dialog for the
right side operations. The next set of operations will drill and pocket the two holes.
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Holes

1. Create this Holes process with tool
#4.

(s
Drill I Hole Feature | Bore | Pre-Mill| MilFeature |
Entry/Exit Cyde: (O Dimension from Hole
(O Feed In - Rapid Out (®) Dimension from Tool
gFeedIn‘Feed()ut AtOpEnd
Tap 1 0.1
R
Origid Tap
® Peck, Full Out
(O Pedck, Chip Breaker -42.983
Ot T
(O Finish Mill Bore
(O Helix Bore
QO [Bore v —
Load H1D
Transition Between Holes
Material @R Level 1
5 340 (OpPart Cearance 15
| = m gAbsol.ltz z
Hole Feature 0

v o

[ Vary Depth With Geo.
Clearance 1 v

" D Reverse Order

Pe 3.2

[ coolant

et [~ Flood

[[] 1 Direction

[Jrattern: 1: Workgroup v

Mach.CS: | 1:XYplane v|
Comment
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Pocket | il Feature | Soics | Open Sides| Offset/Trim | Entry/Exit |
Offset ~ (O Depths from Feature
e (®) Depths From Tool
— S E ) !
e s e anv |
- DNy, e
Cut viidth
Entry And Exit Z5te
@ Line 0.2 Desired Actual #Passes
90° Radius 1 1535 ’
O90°Line [JRetracts ~ [“DepthFirst [7]Prefer Subs
O Advanced Do not hit flats ~
2. Create this Roughing process with tool T >
#3. andstok: [0 |
ot [T
Overlap I:l []Round Corners Break D
Spring Passes D [Jcrcon [ cimb
e ] Coolant
[ Flood
[ use stock [pattern: 1: Workgroup
b Material Oriy Mach. CS: 1: XY plane v
[ 1gnore Prior Tool Profiles
[[J outermost Shape As Boss
Comment ‘

3. Selectthe two circles and c1ick the Do it button.

4. Create the drilling and pocketing operations for the right
side part. Make sure that you change the Mach CS to G55.

Shallow Pockets

The final set of operations will pocket out the inside of the part, creating the 0.1" wall around
each of our pockets.

69



Work Fixture Offsets

Pocket | il Feature | Soics | Open Sides| Offset/Trim | Entry/Exit |
Offset v (O Depths from Feature
’m (®) Depths From Tool
= ] s IC.r
| EntryFeed | | 1108 LRapidin AR
— ) e
cuwe
Entry And Exit Z5tep
@ Line 0.5 Desired Actual #Passes
sorRadus |1 [ J[ess J[5
O 90°Line [JRetracts [ Depth First [Prefer Subs
O advanced
1. Create this Roughing process with tool Podket Stock + e >
#3. endStok:  [2 |
ot 1]
Overlap I:l []Round Corners Break l:l
N =
] Coolant
[ Flood
M use stock [Pattern: | 1: Workaroup v
[ aterial Only Mach.CS: | 1: XY plane v
Ignore Prior Tool Profiles
[Joutermost Shape As Boss
Comment A

v
Contour | il Feature | Soids | Open Sides| Offset | Entry/Exit |
@ O Depths from Feature
(®) Depths From Tool
Speed: RPM
EnE D | B
’m [CJRapid In AL 0°
Entry A Bt Iy -
@)Line
90° Radius
Z5tep
O390°Line Desired Actual =Passes
O Advanced E 25 1

[Retracts  [“IDepth First [~] Prefer Subs
[JRamp Down [JBack &Forth

Do not hit flats e

No. of Extra Offsets

Extra Stepover

2. Create this Contour process with tool

T [ e

#5 Stock £
' Zstodk Auto Plunge v

Overlap Round Corners Break D

Spring Passes Cutter Radius Comp. On

[CJuse stock Coolant

Material Only E Flood
Ignore Prior Tool Profiles

[ratten: | 1= Workoroup ~|
Mach. Cs: 1: XY plane ~

Comment A
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3. Select the outside contour of the part and
each of the four pockets inside. C1ick the

Do it button.

process dialogs using the Mach CS: G55.

Create the set of operations for machining the right side part using the same parameters in the

All of the operations to machine both the left and right side parts have been completed.

When using work fixture offsets to machine multiple parts, a B Style Advanced CS Processor
should be used so that the code calls G54 or G55 for the offset shifts rather than specifying them
in the code itself. This way, the proper origin shifts can be entered at the machine in the work
fixture offsets to reflect the actual locations of the parts on the machine.

Top and Bottom Machining

In this exercise, we will create a program that will machine the top and bottom of a single part. This
is often accomplished using pallets and flipping the pallet for the back side of the part; a manual
fourth axis rotation. Because of this, we will program this part for a 4-axis vertical machine, in order
to generate accurate code. However, this part is designed to be machined on a 3-axis machine with
a manual flip for the back side operations. We will insert a program stop to facilitate the flip. For the
part print for this exercise, see “Top and Bottom” on page 110.

Making the Model
Part Setup

1. Create a new metric part with a 4 Axis
Vertical Mill MDD. The part should have
stock dimensions as shown with a
Clearance Plane value of 250mm. Select a
die cast aluminum alloy for the part
material if you have the CutDATA material
database.

+X 200 N
+Z2 0
-0 . |
-
&Y 100 '
s Z 50
-0
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Rotate Around

ox X 0
@ Zo0
2. Clickthe Machine Setup tab and enter ©z

information into the dialog as shown. ¥
[[] Axis Limited

Min. Limit

Max. Limit

A Master Clearance Plane value of 250mm will give us plenty of room
to rotate the part about the Y axis.

CS Creation

First, we will create a new coordinate system for the back side of the part. This CS will be the XY
plane with a different origin. The way we have set up the part, we will be using the Y axis as the
rotation axis around which the part will be flipped. The following diagram is intended to illustrate
how to visualize where the origin should be for the back side coordinate system.

1. Origin 1
2. Origin 2

4th Axis Y Flip 4th Axis X Flip

1. Create anew CS and label this CS Back Side.

2. Clickthe Change CS Origin button in the CS palette and enter the information shown below.

Change C5 Origin A E
- 1= HD
® 200 [7] Duplicate
Nl
£ |80 Dolt |

3. Toggle the depth of the CS.
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The part’s coordinate systems are set. We will now create the part geometry.

Geometry Creation

1. Switch to the Home view for CS2, Back
Side.

You can use the part model on the track
ball to get an idea of the orientation of this
CS inrelation to the top of the part
indicated by the “T” on the model.

2. Create the geometry for the back side of the part which is drawn in view B-B on the part print.

3. Switch to CS1: XY Plane. Create the top side
geometry shown in view A-A on the part
print.

All of the geometry and coordinate systems
are now correctly defined. We will now
move on to setting up the machining of this
part.

Machining the Part

Tool Definition

1. Create the following tool list:

Total . . # Flute .

# Type Length Diameter Corner/Tip Flutes Length Material
1 rEM 110mm  12mm Omm 3 53mm HSSTIN
Coated

2 fEM 110mm  12mm  Omm 3 53mm  Hoo TN
Coated

3 Dril 82mm  6mm 118° 2 na o HSSTIN
Coated

4 Dril 120mm  12mm  118° 2 NA - HSSTN
Coated
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Top Side Pocket
First, we will create the operations to machine the top side pocket.

Pocket | il Feature | Soids | Open Sides| Offset/Trim| Entry/Exit | Rotate|
Offset ~ (O Depths from Feature
‘ ] (® Depths From Tool
== ERE ) BECRE
[EntryFeed | [847 Dlrapid in AL 0°
Contour Feed. Ny 77
cavn [
Entry And Exit Zstep
OlLine Desired Actual # Passes
00 Racks CEEEC :
@ 90°Line D [Jretracts  [IDepth First []Prefer Subs
. . . O advanced Do not it fiats -
1. Create this Roughing process with tool e F .
#1. Island Stock &
s [
Overlap Izl [ Round Corners Break l:l
ino Passes D [Jcrcon M Climb
spring ] Coolant
[ Flood
£ use stack [Pattern: | 1 Workgroup v
[[Imaterial Only
Ignore Prior Tool Profiles
[[] Outermost Shape As Boss
Comment

Be sure to select CS 1 as the Mach CS in the Rotate tab.
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Contour | il Feature | Soids | Open Sides| Offset | Entry/Exit | Rotate|

Material (O Depths from Feature
. (®) Depths From Tool
—_—

Biyred|  [2%1 e
Contour Feed LRapdin i
e D

@ Line -
90° Radius
Z Step
(O90°Line Desired Actual #Passes
O Advanced 10 3

[Retracts  [“IDepth First [~] Prefer Subs
[JRamp Down []Back &Forth

No. of Extra Offsets

a Stepover

2. Create this Contour process with tool

T 0 e

Stock = Donothitfies |
#2. o — v
Overlap ] Round Corners Break D
Spring Passes [ Cutter Radius Comp. On
[Juse stock 4 Coolant
Material Only [ Floed

Ignore Prior Tool Profiles

[rattern: 1: Workgroup

Comment

3. Select the pocket and island geometry and c1ick the Do It button. o
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Top Side Holes

1. Create this Holes process with tool
#3.

2. Selectthe points or circles for the top side drill holes

and click the Do it button.

Holes operations can be applied to either points or

circles.

3. Render the operations.

g (s
Drill I Hole Feature | Bore | Pre-mill | Mil Feature I Rotate |
Entry/Exit Cyde: (O Dimension from Hole
(OFeed In - Rapid Out (®) Dimension from Tool
(® Feed In - Feed Out At Op End

Qe TR

Oprigd Tap
(O Peck, Full Out
(O Peck, Chip Breaker
(O Rough mill Bore l:l—
(O Finish Mil Bore
(O Helix Bore
O Bore
Load H1D
Transition Between Holes
| Materia @R Level 2
Part Clearance 250
| [0 ] O
(O Absolute Z
e
(O Hole Feature
Clearance [ vary Depth With Geo.
[[JReverse Order
[ coolant
o [ Flood
[ 1 Direction
[Orattern: | 1 Workgroup
Comment
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Inserting A Program Stop

The operations to machine the top side of the part are complete. Now, we need to insert a
program stop into the posted code before the back side operations. The program stop will allow
for the flipping of the part. A program stop can be specified in the Operation Data dialog of any

operation.

1. Right-click the operation tile and select Operation Data.

Another way to access the Operation Data dialog is by
Double-clicking on the tab for the operation tile. The
operation tab is the item that has the number of the
operation oniit.

L

T3

(7

Operation Data... [

Utility Markers...

Open Tool..
Operation To Geometry

Redo Selected Ops
Redo All Operations

Move To...
Find...

Sort Operations
Operation Medifiers...
Operation Manager...

Small lcons

Large lcons
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Flood -y
SpeediRPM 1940 n, ,”g
Entry Feed 143 Y
Contour Feed 2218 Y
. . .,
2. Select the Program Stop option in the Operation [lpattern o, TOfeets 3 L
i  EE— L}
Data dialog. [Update Pattern | [Cercon 4
Rotate CRC Offset #
SCo.lamment,
q Flip the part > -
Utility Data
At Op Start

This will create a program stop, usually MO, in the posted code after operation #4 has been
completed. Additionally, we inserted an operation comment, F1ip the part, that will show up
in the posted output.

Back Side Pocket

Now, we need to program the operations to cut the back side of the part. We need to make sure
the Mach CS is set to the Back Side coordinate system.

Pocket | il Feature | Soids | Open Sides| offset/Trim| Entry/Exit | Rotate|
Offset ~ (O Depths from Feature
] (®) Depths From Tool
=== S E ) 1
Entry Feed 847 ClRmiim w07
ContourFecd Ny
Cut viidtn [ ]
Entry And Exit 2 step
Oline Desired Actual # Passes
90 Radius 52 N
@90°Line D [JRetracts ~ [ZIDepthFirst [/]Prefer Subs
O Advanced Do not hit fiats ~
1. Create this Roughing process with tool Podetswcks  [1 | o -
#1. Island Stock £
B
Overlap Izl [ round Corners Break El
0 Passes D [Jcrcon [ climb
sering ] Coolant
[ Flood
[l use Stock [Jrattern: 1: Workgroup
[CIMaterial Only
Ignore Prior Tool Profiles
[[J outermost Shape As Boss
Comment

Be sure to select CS 2 as the Mach CS in the Rotate tab.
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Contour | il Feature | Soids | Open Sides| Offset | Entry/Exit | Rotate|

Material (O Depths from Feature
. (®) Depths From Tool
s
Gyresd | [ RERNR ) 1
R In o

Contour Feed Lrapid Al
Entry And Exit 0 N 77 +
@ Line -

90° Radius

) ZStep

Os0°Line Desired Actual #Passes
O s 2

[Retracts  [“IDepth First [~] Prefer Subs
[JRamp Down []Back &Forth

No. of Extra Offsets

a Stepover

2. Create this Contour process with tool

T 0 e

Stock = Donothitfies |
#2. o — v
Overlap ] Round Corners Break D
Spring Passes [ Cutter Radius Comp. On
[Juse stock 4 Coolant
Material Only [ Floed

Ignore Prior Tool Profiles

[OJrattern: | 1 Workgroup

Comment

3. Select the slot on the bottom side of the part and
click the Do it button.
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Back Side Holes

7 ICE
Drill I Hole Feature | | pre-mil | Mil Feature 1 Rotate |
Entry/Exit Cyde: () Dimension from Hole
(O Feed In - Rapid Out (®) Dimension from Tool
(®)Feed In - Feed Out At Op End
Orap 2
(ORigid Tap
(OPeck, Full Out
OPEd(, Chip Breaker -52.301
(O Rough Mill Bare
55 906
(O Finish Mil Bore [—l
(O Helix Bore
O Bore
Load H1D
Transition Between Holes
i . Material @R Level 2
1. Create this Holes process with tool o [m | Ordeme |
#4 (O Absolute Z
. Feed 296
(O Hole Feature

Dwell 0

[ vary Depth With Geo.

[[JReverse Order

[ Coolant

[] Floed

[ 1 Direction

[Jrattern: 1: Workgroup

Comment

All of the operations to machine both the top and bottom of the part have been completed.

When using work fixture offsets to machine different sides of a part, a B-Style Advanced CS
Processor should be used to post the file. The operations that machine the top side of the part
will all be done in G54. Then there will be a program stop in the program so the operator can flip
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the part. The back side operations will be done in G55 so the origin shift for G55 must be entered

for the work fixture offset correctly at the machine.

o

PostEditor - DhGibbs sample partsiAdvanced CS\Hinge iIFEEEL

Load File

Sawe File

A—rA
A-a

i

NT1M5 -
NT2M0

N73G1TG40G80

NT4T1

NTSMB

{ OPERATION 5 ROUGHING )

{ WORKGROUP )

{ TOOL 1: 12. ROUGH ENDMILL )
{ C5&2 - BACK SIDE )

( G55 = X200. Y0. 750 )
NTBGSS

NTTS2223M3

EITE M 4 W BN A 4o

m

.\

The highlighted rows show the
Program Stop and the rotation.
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TOMBSTONE MACHINING

* Tombstone Machining

* Post Processing

Tombstone Machining

There are several ways to accomplish tombstone machining with the system. All of them require the

Advanced CS option and a CNC machine capable of handling B-axis numbers in the WFO. The
post processing is the same for all methods. The following three sections go over the different
methods. The pictures shown below show our perspective of the tombstone and parts. For the
dimensional data for the part print, see “Tombstone Machining” on page 109.

1. First Part

2. Second part

3. Third part

4. Fourth part

5. Front view of first part
6. Leftside of second part
7. Right side of fourth part
8. Origins

9
1

. Clamps
0. Tombstone

Top view Front view

Top and Front views of a Tombstone Setup

Method 1: Per the Machine

In this example we will demonstrate what will actually happen at the machine. The initial stock
size encompasses the tombstone and the first, second, and fourth parts. For this example, we
are looking at the “front” view, as shown above.

We will create the geometry and operations necessary to machine everything available from the
“front” view; the front side of the 1st part, the right side of the 4th part and the left side of the 2nd
part.

Then the post processor will be used to duplicate this information for the other three sides of the
tombstone. This method has the benefit of allowing us to see the tool move from the side of one
part to the face of another so that we can check for tool interference.

For the sample part that accompanies this tutorial, see the sample file Tombstone Method 1.vnc.
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Workspace | Mutti-Part | Interop Positions | Intermediate Tooling Post Processor # - X
Multi Part Type | Part Duplication ~
I [y
Duplication Type L. - . - L
_ Part Origins From: () Machine Origin (®) Part Origin
() Equally Spaced [E1 »
) i Part X Offset ¥ Offset Z Offset =
- 0 Par Duplicaton
® Define Positions 1o 0 T a il
[+#] Use \Workfixtures
Traversal Options 2 175 0 0
() Off Part Location
(®) Part Clearance 3 750 o 0 2
[] Complete Each Part First 4 1125 ] ] b

[] Back and Forth

Part and CS Setup

1. Setup a4-axis horizontal part with the stock size large enough to
encompass the first part, second part, fourth part, and the
tombstone including the clamps.

We will create three coordinate systems, one for each side of the part. All of these coordinate
systems will be set in the XY plane, but will have different origins. The advantage to setting three
separate planes is that the information entered in the machining process dialogs such as the
clearance positions and cut depths are relative to the origin and coordinate system in which you

are working. The images in this tutorial show a part with custom stock that encompasses the
tombstone and all four parts.

2. Inthe standard XY plane create origin points for each of the
sides.

These origin points can lie anywhere in the plane. For the part that we have included for the first
example we chose the bottom left hand corner of each side to act as the origin.
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3. Openthe CS dialog and dock it on a convenient side of the screen, as you will be using this
extensively. (Click the dock symbol m on the dialog and drag the CS titlebar until the arrow
cursor is situated over the area you wish to dock to.)

4. Create anew CS. Change the origin to the origin point you created for the 1st part. Label this
CS Front view of 1st part.

s ey =
Comment WO
1 2 W plane

e

5. Createanew CS (CS3). Change the origin to the origin point you created for the 4th part. Label
this CS Right view of 4th part.

cs ] k5|
Comment WEO

1 = w5y plane
2 % Front View of 15t Pat 1

6. Create anew CS (CS4). Change the origin to the origin point you created for the 2nd part.
LabelthisCS Left view of 2nd part.

s HES
Comment wFO

1 0 plane

2 S Front Yiew of 1zt Part 1

3 £ Right View of 4th Part 4

4 o Left View of 2nd Pat 2

Machining

1. Switch to CS2. Create a new workgroup. Label this workgroup Front of 1st part.Inorder
to better visualize what’s going on, create an outline for the stock size of the front of the part.
Create the geometry and operations for the machining of this side.
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2. Switchto CS4. Create a new workgroup. Label this workgroup Left side of 2nd part.
Create the stock outline for the left side. Create the geometry and operations for the machining
of the left side. In the sample file there are two holes on the left side.

3. Switchto CS3. Create a new workgroup and label this workgroup Right side of 4th part.
Create the stock outline for the right side. Create the geometry and operations for the
machining of the right side. In the sample file there is one drilled hole on the right side.

The rendered image will not look correct unless extra operations are created to clear off the
extra stock between the parts. This can be done by creating contour operations with a large tool
to wipe off the excess on each side. These operations should be thrown away before post
processing. In our example we have cleared off the excess stock. This is not necessary, but
does make the rendering process more visually representative.
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Method 2

In this example we will create one complete part, as if we were simply machining a single unit. This
allows us to verify that the toolpaths will generate the correct part. It is especially useful when
checking to make sure cuts made in one side intersect cuts made on another where they are
supposed to.

When we’re finished, we can do one of two things. We can either post process the file as is and strip
out the extra B moves from a C or D style processor (there will be three of them,) or we can create
new coordinate systems like in example 1 and “unfold” the part so it looks like it would on the
tombstone. Unfolding the part is more work inside of the system, but it does help us see the part as
it would be machined.

Part and CS Setup

1. Setup a4-axis horizontal part. The stock dimensions should be that of a single part.

2. We will create three coordinate systems, one for each side of the
part. The first CS will be for the front side of the part and will lie in
the XY plane. The second CS will be for the right side of the part
and will lie in the -YZ plane. The third CS will be for the left side of
the part and will lie in the YZ plane.

3. Again, in the standard XY plane, create origin points for each of the sides.

These origin points can lie anywhere in the plane. For the part that we have included as
Example 2, we chose the bottom left hand corner of each side to act as the origin.

4. Create a new coordinate system (CS2). Change the origin to the origin point you created for the
front side of the part. Label this CS Front side.

5. Createanew CS (CS3). Set the plane to the YZ plane. Change the origin to the origin point you
created for the right side of the part. Label this CS Right side.

6. Create anew CS (CS4) Toggle the depth. Change the origin to the origin point you created for
the left side of the part. Set the plane to the YZ plane. Label this CS Left side.
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Left side Front side Right side

Machining

1.

Switch to CS2. Create a new workgroup and label the workgroup
Front side. Create the geometry and operations for the
machining of the front side. In the sample file, Tombstone Method
2.vnc , there are 2 operations on the front side of the part.

Switch to CS4. Create a new workgroup. Label this workgroup
Right side. Create the geometry and operations for the
machining of the right side. In the sample file there is one drilled hole
on the right side.

Switch to CS3. Create a new workgroup. Label this workgroup
Left side. Create the geometry and operations for the machining
of the left side. In the sample file there are two holes drilled on the
left side.
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4. If yourender the part at this point you will be able to see what one
finished part will look like.

If you are using a B or C style post processor, you can post process the part now. If you process
at this point you will need to remove the B axis moves and change the numbers at the control for
the origins of the WFOs. If you are using a D style post processor, you must “unfold” the part
before post processing.

Unfolding a Part

When you “unfold” a single part, it will work the same as method 1. To “unfold” a single part, we
need to change the three coordinate systems so that they match the ones we created in
Example 1. The sides will automatically unfold out and move into position. We will also change
the stock size to encompass parts one, two, and four, as well as the tombstone.

1. Switchto CS1, the XY plane. Create origin points for the
three side. These origin points will be in the same locations
as the origin points in Example 1, Front view.

2. Switchto CS2, the Front side. Change the origin to the new origin point you created for the
Front side. When you switch the origin of the plane, the operations that you created in that
coordinate system should shift accordingly so you do not need to adjust or reprocess the
operations.

3. Switchto CS3, the Right side. Change the origin to the new origin point you created for the
Right side. Note that the origin for the plane containing the right side is actually on the far left
side when it is unfolded because in this setup we are machining the right side of the fourth part
which is attached to the tombstone on the left. (For more information, see “Top and Front views
of a Tombstone Setup” on page 82.) Also, you need to set this CS to the XY plane.

4. Switch to CS4, the Left side. Change the origin to the new origin point you created for the Left
side. Again, the origin for the left side appears on the right side in this set up. Also, you need to
set this CS to the XY plane.
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Method 3

This example is designed to reduce the number of WFOs needed to machine the part. Instead
of creating different coordinate systems, we will simply use the standard XY plane. You only
need one WG and one CS. All geometry is created and machined in the standard XY plane.
Basically, this is how tombstone milling would be accomplished without using the Advanced CS
module. Using this method the depth values need to be calculated and entered in the process
dialogs. The rendered image will have the same problems as Example 1. To solve this you will
need to create temporary operations to remove the excess stock. This method is useful if your
machine can only handle a small number of WFOs.

Post Processing

Using any of the methods outlined above, once you have created the part, post process the file
using work fixture offsets and 4 parts. Advanced CS post processors come in three styles.

B Style:
WFOs used for origins and indexing for single and multiple parts.

C Style:
WFOs used for origins for single parts. WFOs used for origins and indexing between parts for
multiple parts.

D Style:
WFOs only used for indexing between multiple parts.

If your CNC machine does not have the number of WFOs required to machine the part, Band C
style processors will revert to D style.

The indexing must be handled by the work fixtures. The first three work fixtures will be at B0, the
next three at B90, the next three at B180, etc. If there are partial rotations for the parts, they will be
handled by creating additional coordinate systems and will result in more than three coordinate
systems per side. The actual rotation to get to these other sides will show up as “BXX” commands
in the code for the C and D style processors. Since each side will have the correct rotation for the
partin the WFOQ, the partial rotations will work fine. The B style post will output a comment
containing the partial rotation amount. For the parts on the second, third, and fourth sides of the
tombstone, the 90° index increment will need to be added to the partial rotation amount.
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CREATION AND MACHINING CONCEPTS

This chapter contains short, how-to tutorials. Each tutorial is focused on a topic, such as making a
bottle mold, working with multiple part origins or driving a tool along the Z axis.

* Multiple Part Origins
+ Bottle Mold

* Drivingthe ToolInZ
* Rotary Milling

Multiple Part Origins

Using Multiple CS’s for Geometry Creation

In this exercise, we will use multiple part origins to simplify the creation of geometry. The different
part origins will not be used with work fixture offsets as they were shown in previous exercises, see
“Family of Parts” on page 61, or “Top and Bottom Machining” on page 71. Rather, it is the way the
part is dimensioned that makes using different part origins the best way to create the part geometry.
This exercise uses a standard Mill post processor and a 3-axis MDD. For the part print for this
exercise, see “Multiple Origins” on page 111.

Part Creation

1. Create a new metric part using a 3 Axis Mill MDD with a stock size of
X=-5,300; Y= -5, 225;7= -25, 0.

First, we will create the outside contour of the shape. All of the lines that compose the outside
contour, except for one, are easily created in CS1.

2. Create the geometry for the outside contour that is
dimensioned from the 0, 0 origin on the part print.
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Second CS

3. Create the line to finish the outside contour and the

The line that connects the angled lines to complete the outside contour is dimensioned from a
different origin on the print. While we could figure out the dimensioning for this line, it would take
a bit of work. Instead, we will create another coordinate system with a new origin.

Create anew CS and select the point circled as the origin.

The new CS is an exact duplicate of the standard XY plane;
the only thing that has changed is the origin. To further
modify the new CS, we will set the horizontal axis to one of
the angled lines. This will not change the planar location of
the coordinate system, only the CS grid orientation.

Align the horizontal axis to the line shown with the arrow above.

Now, the angled line that completes the outside contour is very simple to create. You can simply
define the line as a vertical line with an H value of 200mm.

hexagon while working in CS2.

Completing the Geometry

1.

Switch to CS1 and select the hexagon and line we just created in CS2.

2. Choose Modify > Change CS (XYZ).

All of the part geometry should now be either yellow or blue in CS1 indicating that it is based on
the current CS.
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3. Connect the outside contour and create the bolt hole
pattern to complete the part geometry.

The part can be machined just as it would be if you were working with the Production Mill
Module. All operations should have the Machining CS in the process dialogs setto CS1: XY
Plane.

Bottle Mold

In this exercise we will make a bottle mold. This exercise uses a pre-existing part file that contains
the bottle profile and a tool.

About Bottle Molds

Bottle molds are created in the system using the 2 1/2 axis surfacing capabilities. More specifically,
bottle molds are created using the swept shape option for machining contours. Swept shapes are
created by designating a base curve, which is the cut shape, that will be machined based on a drive
curve. The drive curve designates the shape of the wall that will be swept around the base curve to
create the surface.

For bottle molds, the base curve is an arc and the drive curve is the contour that represents the
shape of the bottle. Normally, the base curve is defined in either the XZ or YZ planes and the drive
curve is defined in the standard XY plane. All machining will be done from CS1, which is the
standard XY plane.
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The general rule when creating bottlemolds is that the depth axis of the base curve must align with
the vertical axis of the drive curve (the bottle profile). When the Machining CS and the drive curve
plane are perpendicular, the system will output G17, G18 and G19 codes to provide for the
machining of the arc rather than breaking it into line segments.

Creating the Bottle Mold

For this part, we will create the base curve, which is a 13mm arc in the XZ plane. The drive
curve, which is the shape of the bottle in the XY plane, is already created to save time. We will
need to properly position the drive curve to complete the part. If you need to recreate the profile
shape for this exercise, see “Family of Parts” on page 108.

1. Open the file Bottle Mold.vnc, which is located in the Part Files > Advanced CS folder.
This part is set up to use a 3-Axis Vertical Mill. The Clearance Plane value of 15mm is plenty of
clearance over our X:-10/+193, Y:-10/+70, Z: -50/0mm part.

Creating the Base Curve

First, we will create the base curve geometry, which is a 13mm arc in the YZ plane.
1. Createanew CS.

2. Modify the CS to the YZ plane.

3. Clickthe Toggle Depth button.

4. Create a 13mm circle in the YZ plane around the
centerpoint H -31, Z0, DO.

We need to create terminator points to create the semi-
circle (arc) that will act as our drive curve.

Now, we will create the drive curve geometry which is the contour of the bottle. There must be
terminators at both ends of the drive curve.
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Correctly positioning the drive curve is very important in order to generate the desired toolpath.
The general rule is that the vertical axis of the drive curve is going to align with the depth axis of
the base curve.

In this exercise, we will create the drive curve geometry in CS1, which is the standard XY plane.
Once the geometry is created, we will 2D Rotate the contour 90° so that the vertical axis of the
drive curve will correctly align with the base curve depth axis.

5. Change to CS1 and create the drive curve geometry. Refer
to the part print for the dimensions.

The drive curve geometry does not need to be created in
position because we will be rotating it. However, it is drawn
in the screenshot on the left in position for visualization
purposes.

Now, we need to rotate the drive curve 90° so that it is oriented correctly.

20 Rotate =HE=

6. Make sure that you are working in CS1. Select the drive curve Around
shape. Choose Modify > 2D Rotate and enter the information shown. %D
The orientation of the drive curve is what is important, not its exact L
location in the coordinate system. As long as the shape is rotated
90°, the point around which it is rotated is not important. The @cw O Cow
location of the bottle mold toolpath will be determined by the base fngle |90

curve, which is in position.
[ wizible Wiz Do It

Next, we will create contouring processes which will generate the bottle mold toolpath.
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7. Create a 10mm Ball Endmill.

QN

Contour | il Feature | Soids | Open Sides| Offset | Entry/Ext | Rotate|
Material
Speed: RPM 702
ewyresd | [ CIERR N ) BN
= O s
Entry And Exit N 77 +
i :
90° Radius
. (O
Os0°Line Desired actual # Passes
(O Advanced -13.5 0
No.of Exta Offcets [0 | [ORetracts  [ADepthFirst [ Prefer subs
. . S Ramp Down []Back &Forth
8. Create this Contour process with the ball ' e <]
. Stack + : s 7
endmill.
ZStock Auto Plunge v
Overlap D ] Round Corners Break l:]
Spring Passes Izl Cutter Radius Comp. On
Ause Stock ] Coolant
[AMaterial Only [ Floed
[ 1gnore Prior Tool Profiles
[rattern: | 1 Workaroup
Comment ‘

Since our flute length is smaller than our final depth of cut we will need to do this contour in
several Z passes. Z stock will create the contour toolpath and translate the cut in Z the distance
specified. We will take two passes with Z stock applied before taking the final cut. The only
information we really need to be concerned with is entered in the Wall Choices dialog.
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Wall Choices = lea = =)
~ Straight, 0" taper
@ Swept shape
_ DCEP Leit
@ DCEF Right
Taper ve/Filetz
Top Fillet

Side Angle

9. (Clickthe Swept button and enter the information shown.

Bottorm Fillst

& Top Down ) One diraction
~ Bottom Up @ Back & foith

_ Usar [ Step
& Shape Step 2

“Hidge Heaght

10. Select the arc as the base curve. Set the direction to
contour into the arc.

The machining markers that appear for contouring
operations will come up on the screen. The D-marker,
which designates the drive curve for swept surfaces, will
also appear.

11. Click the Do it button.

12. Using the same process, create 2 more contour ops with Z Stock at 7 and then 0.
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Driving the Tool In Z
About the Part

In this exercise we will start with a mostly completed part. We will add the finishing touches by
adding grooves along the edges of the part.

1. Open the part file Z Machining.vnc from the Part Files > Advanced CS folder.

If you would like, now is a good time to run cut part rendering as it will help you familiarize
yourself with the part.

Start Finish

Setting Up the Part

1. Fromthe XZ plane copy (Ctr1+C) the profile geometry (the magenta geometry).
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o

Create a new WG called Grooves and anew CS called CW 22.5.
Paste the copied geometry into the Grooves WG.

You may note that the geometry is still magenta. That is because the geometry is still assigned
to the XZ plane. We will need to change that.

If you are not already in it, switch to the CS Cw 22.5.

Assign the geometry to the current CS using Change CS (XYZ).

Modifying the Geometry

Profile Shape

We used a 13mm BEm to cut the part, so we have a 6.5mm radius on the bottom of the part. We
will be driving the tool onto the part and up the profile but the profile stops at the top of the fillet.
Therefore, we need to create the geometry to replicate the fillet. This way the tool can start off
the part and cut up the edge of the part.

Make a vertical line tangent to the right side of the profile.

Make a horizontal line 6.5mm below the profile.

Create a circle with a 6.5mm radius between the two lines. The circle will
arc down and to the right from the profile, as shown in the image.

4. Connectthe new arc to the profile geometry and terminate the line at the
stock boundary (X=42.5mm).

You may delete the vertical line, but do not delete the horizontal line. In
fact, make sure the horizontal line is connected to the arc — we will use it
for driving the tool onto the part. The line does not need to be terminated.
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Making the Grooves

To create the groove profiles we need to duplicate the geometry, and then duplicate and rotate

the geometry and the CS into the proper positions.

1. Select the profile geometry. Duplicate and mirror the geometry about the X axis.

2. Deselect the geometry.

Mirror = I =l

Walues To Mirrar
H |0
[z |355

[ClD |0

You will now have identical geometry on both sides of HO. We now need to rotate the CS and
geometry. Deselecting the geometry is important as we are going to be modifying the CS

origins.

3. Open the CS Align dialog and rotate the CS clockwise about the Z axis by 22.5°.

The geometry should move with the CS. If the geometry does not move, Undo the rotation and
change the CS Preferences by Right-clickingthe CS list title bar.

4. Rotate and Duplicate the CS 3 times by 45° around
Z.

C5 Align HEH-E
30 Portz
- e R e e R e R e R S e
@ Fotate
Az
Ange 45
X ©H ]
Y @&V @ Cw
@z @op T|0 Cow

Wowkss [ e [CDei)

5. 2D Rotate and Duplicate the geometry 3 times by 45° around X0YO (from the XY plane).

You will now have four pairs of profile geometry that align to four planes.

6. Assign each pair of geometry profiles to the planar CS.
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Itis important to get the geometry into the proper CS at the proper depth because the machining
depth is specified by the geometry’s CS.

Machining the Grooves

Contour Operations

To machine the part we will need to select each profile shape and apply a contour process to it.

1. Ifyou are not already in it, switch to XY plane.

Contour | Mil Featre | Solds | Open sides| offset | Entryjext |

Material (O Depths from Feature
(®) Depths From Tool

Speed: RPM 5000

yres S ERE ) EERERL

G e P amv |

cs e DNy ) O

OlLine

90° Radius
(®) 90° Line IIl E::ed Actual # Passes
. (O Advanced 0 1
2. Select each profile shape geometry o ortaors [T | Elveracs  Eloeohst D s

individually and apply the machining [Ramp Down [Jsack &Forth
settings as shown to make an operation for Stock & 0| [(omeththes ¥
each shape. You will need to repeat this zstock 0| b v
seven times. Overiap | [Orowdcomes

Spring Passes D [ cutter Radius Comp. On

[Juse Stock ] Coolant

Material Only E Flood
Ignore Prior Tool Profiles
[Odrattern: | 1 Workaroup
Mach.CS: | 1:XYplane v
Comment
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Be sure to deselect each
operation tile before
selecting the next profile
geometry and making the
next operation.

3. Render the operations.

Rotary Milling

Rotary milling can be done in any CS whose origin is at the part origin and whose axis of rotation
lies in the origin’s planes. The rotary machining motion is always about the axis with 360° of
rotation. Rotary milling may not be done around an axis perpendicular to the part’s rotary axis,
which means you may not do B-axis rotations or rotations about the 5th axis.

The Rotary Part

We will now do a quick exercise that goes over some of the ways coordinate systems may be
used with rotary machining. We will start with an existing part with a rotary operation. We will
make a new CS, define some text geometry and engrave the text shapes.
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About the File

1.

Open the part file Rotary Text.vnc.

This part is partially complete with pre-existing ops including 3 drilling operations and a rotary
milling operation. This drilling operations require Advanced CS to make the -YZ plane and to
machine from it. The rotary operation does not need Advanced CS. That is done in a Rotary
Milling WG. One point is made, (in this case X4, A-90, R35) a second point is made at the end
of the spiral, including rotations (X46, A1350, R35) and a line is connected between the points.
The angle is determined by multiplying the # of rotations by 360 plus the starting points angle, in
this case (360x4)+(-90).

Making the Text

CS and Geometry

1.

Make a new CS and set it to the XZ plane.

Change C5 Origin EsHEH=
8 MYZ ) HYD
.. ® B0 [T Duplizale
Move the CS origin as shown.
Y0
£ |50 Dol
5 Align BE-E
J_WEIJ Port: P ]
@ Roame T
. i
Rotate the CS about the depth axis by 45° . : Argle |45
clockwise as shown. Name the CS XZ mod. DY BV & Cw
Sz @p VO S CoW
| Duphecate Dalt

Create text geometry as shown below. Be sure that you are in WG1 as it is a rotary milling WG.
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Text Creation L | 3 | (=Y
Tewt | Spacing | Test Flow |
Align. Pt Moopark [=]
HIO -
Z0 ] ﬁ_Ile %
D= | —
(=)=

Gibbs:

Machining the Part
Contour Process
Contour | MilFeatre | Soids | Open Sides| offset | Entry/Exit | Rotate|
Material (O Depths from Feature
. (®) Depths From Tool
—
| entryFeed | 4 _n_ 1
— . [ BN |
Entry And Exit 35 B 77 S
(®)Line 0 -
e
O90°Line Desired Actual # Passes
S it
1. Using tool #5 (a 3.15mm center drill) No.ofExvaofies [0 | E:"*: g::(“’&i_f;gm““m
Extra Stepover mp Lown "
create a Contour process to engrave the m; D T T
text using the parameters shown. Be sure rens ] e
to set the Rotate tab as shown below. overiop [ | Cromcmes  sek [1 ]
Spring Passes D [~ cutter Radius Comp. On
[Juse Stock [~ Coolant
Material Only E Flood
Ignore Prior Tool Profiles
[Jrattern: 1: Geometry
Comment

Conhxlr' Mill Feature | Solids | Opensi‘lﬁl Oﬁsetl Entry/Exit Rotate

MachCS: | 3: XZ Mod |
(O Positions Angle A |0
(® Polar and Cylindrical Miling
Duplicate
T Jumew
.
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When rendered, the part will look like the following image.
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Multiple Origins
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